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Disclaimer

Medoc assumes no liability for use of this document if any unauthorized changes to the
content or format have been made. Every care has been taken to ensure the accuracy of the
information in this document. However, Medoc assumes no responsibility or liability for errors,
inaccuracies, or omissions that may appear in this document. Medoc reserves the right to
change the product without further notice to improve reliability, function or design. This
manual is provided without warranty of any kind, implied or expressed, including, but not
limited to, the implied warranties of merchantability and fitness for a particular purpose.

1 Safety Guidelines and Regulations

This manual is written for trained users of Medoc Products. The user includes the body with
authority over the equipment and those persons who actually handle the equipment.

Before attempting to work with this equipment, read, understand, note and strictly observe all
Warning notices, Cautions and Safety markings on the equipment. The manual and software
are available in English.

Before attempting to work with this equipment, make sure that this manual and any Release
Notes delivered with the software media pack have been thoroughly read and fully understood,
paying particular attention to all:

Warnings
Cautions
Notes

Important Notices

i AW

User Notices

1.1 User Manual Icons

The following icons are used throughout the user manual:

Proprietary 14 of 188




Q-Sense Technical Reference Manual

Warning: A condition that could cause serious injury or death to a
patient and/or operator if instructions are not followed.

Caution: A condition that could cause possible damage to equipment or
cause the system to function inaccurately.

Note: Indicates important user information regarding the use of the
system.

Advice: Refer to instruction manual/ booklet

INSTRUCTION: Indicates an instruction where it is important to follow
the user manual literally as described.

®00eP

1.2 Intended use

The Q-Sense is a device for quantitative thermo-testing in the context of quantitative sensory
testing battery in compliance with Quantitative Sensory Testing (QST) protocols to detect and
quantify sensory loss and sensory gain aimed to precisely characterize somatosensory function
in patients.

1.3 Target Population and Contraindications

The Q-Sense can be used on both healthy subjects and patients suffering from wide range of
neuropathic, CNS and pain conditions. Minimum age reported in the literature is 6.

The only known contraindication is related to the skin on which the thermode is applied - it
must be used in contact with intact skin only. The thermode also intended to be applied on the
skin only, not on the eyes and the mouth.

1.4 Safety and Regulatory Summary

Read and follow all WARNINGS, CAUTIONS and NOTES provided in this manual. To avoid the
possibility of injury, damage to your system, or loss of data, always follow these precautions
during system operation.

e The Q-SENSE system complies with safety requirements for medical electrical systems
(based on the IEC 60601-1 standard).

e The Q-SENSE system complies with electromagnetic emission levels (based on table
201 in the IEC 60601-1-2 standard).

e The Q-SENSE system complies with electromagnetic immunity levels (based on tables
202 and 204 in the IEC 60601-1-2 standard).

e This device complies with 93/42/EEC MDD.

e It is recommended to keep a distance of 3 meters between portable and mobile RF
communications equipment and the Q-SENSE (based on table 206 in the IEC 60601-1-
2 standard).
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1.5 Safety Requirements

The Q-SENSE system can be tested according to IEC 62353 Recurrent test
and test after repair of medical electrical equipment.
Do not modify or replace any component of the Q-SENSE system.
Connecting or replacing external Q-SENSE accessories is allowed.

No modification of this equipment is allowed.

To avoid the risk of electric shock, this equipment must only be connected
to a supply mains with protective earth

Unplug the Q-SENSE system if it is not to be used for a long period of
time.
Do not block airflow anywhere around the Q-SENSE system.

o Keep all liquids away from the Q-SENSE system.

1.5.1 Warnings

e Only personnel properly trained to operate the Q-SENSE system should use this
system.

e Do not turn on system power until all cables have been properly connected and
verified.

e To avoid the risk of electric shock, this equipment must only be connected to a supply
mains with protective earth

e Do not use any power supply which not supplied by Medoc (Medoc’s power supply
Cat.# DT 00017).

e Do not use any electrode paste, gel, or other materials on the contact point between
the Thermode plate and the skin of the tested subject.

e To reduce the risk of injury, place the Thermode on the subject only before starting the
test and while the test screen is visible. After the test is complete, remove the
Thermode from the subject’s skin while the test screen is still visible.

e Connect the Thermode to the patient's skin ONLY during the test; not during system
Self-Test, programming or maintenance.

e The computer that is used to operate the Q-SENSE system must be powered through a
Medical Grade Isolation Transformer only.

e The use of accessories or cables other than those specified, with the exception of
accessories or cables sold by the manufacturer as replacement parts, may result in
increased emissions or decreased electrical immunity of the device.

e Connecting any device or accessory that has no medical grade certificate to the Q-
SENSE system is not allowed.

e Using a Thermode without the appropriate calibration table may result in potential
harm or injury.

e Using the Q-SENSE system not according to instructions may result in potential harm
or injury.
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Adverse Reaction: Skin irritation (in addition to pain sensation) beneath the probe has
been reported with the use of a stimulator, which was based on similar technology as
the Q-Sense device.

Be aware of potential risk of skin damage caused by wrong parameter
combination.

Use of this equipment adjacent to or stacked with other equipment should be
avoided because it could result in improper operation. If such use is necessary,
this equipment and the other equipment should be observed to verify that they
are operating normally.

of accessories, transducers and cables other than those specified or provided by
the manufacturer of this equipment could result in increased electromagnetic
emissions or decreased electromagnetic immunity of this equipment and result
in improper operation.

Portable RF communications equipment (including peripherals such as antenna
cables and external antennas) should be used no closer than 30 cm (12 inches)
to any part of the [ME EQUIPMENT or ME SYSTEM], including cables specified by the
manufacturer. Otherwise, degradation of the performance of this equipment
could result.

NOTE The EMISSIONS characteristics of this equipment make it suitable for use
in industrial areas and hospitals (CISPR 11 class A). If it is used in a residential
environment (for which CISPR 11 class B is normally required) this equipment
might not offer adequate protection to radio-frequency communication services.
The user might need to take mitigation measures, such as relocating or re-
orienting the equipment

1.5.2 Cautions

Proper use of this device depends on careful reading of all instructions and labels.

Turn OFF system power before connecting or disconnecting any system component(s)
or accessories. Otherwise, you may damage the device(s).

The Thermode is very delicate and can easily be damaged. Therefore, handle with
care.

If you disconnect any cables, take care to reconnect them correctly to prevent damage
to the system or components.

Inspect the power cord often for fraying or other damage. DO NOT operate the
apparatus if the power cord or plug is damaged.

The computer that is used to operate the Q-SENSE system must not be connected to a
network while it is used for running tests.

The Q-SENSE system does not require special precautions regarding EMC, and needs
to be installed and put into service according to this manual.

Portable and mobile RF communications equipment can affect medical electrical
equipment.

Use caution when using the Q-SENSE Thermode on patients with suspected
neuropathies as they may be more susceptible to soft tissue or nerve damage at
extreme temperatures. Also, patients with neuropathies may not be able to
properly discontinue use of the device during prolonged hot or cold stimulation.
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1.5.3 Equipment Classification

Degree of protection against electric shock: Class I

Type of protection against electric shock: BF

Type of Operation: Continuous

Protection against ingress of liquids: Not protected against ingress of liquids
Ordinary equipment.

Computer must comply with IEC 950 - EN 60950 - UL 60950.

1.6 System Protection
1.6.1 System Self-Test

Upon start-up the system performs a self-test in which system sensors are being tested. If a
malfunction is detected, an appropriate message is displayed and the system cannot operate
until that malfunction is resolved.

1.6.2 Temperature Safety Mechanisms

Several safeguard mechanisms have been implemented in the system to safeguard against
extreme temperatures and to protect the tested subject and the unit.

Software protection mechanisms include:

Temperature upper and lower limits — In normal operation, Thermode temperature will
always be within these limits.

Time duration limits - Thermode temperature is limited in duration. If the Thermode
temperature maintains a specific temperature (or above) for a longer period of time
then specified for that temperature, the system will go into Safe Mode.

Safe Mode - a protective state of the system in which it is not possible to run tests. In
any case of suspected malfunction or if any modification is made to system hardware
settings, system will remain in safe mode until a system Self-Test is performed.

Hardware protection mechanisms include:

If the Thermode temperature reaches 57°C an analog circuit overrides the system and
lowers the temperature gradually.

1.6.3 Thermode Detection

The system automatically detects that a Thermode is missing, and disables it in order to
protect both system and user.
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1.7 Equipment Labels, Symbols, Warning Statements and

Abbreviations
Thermal Sensory Analyzer
TSA 2001 E AS 00400/
Model: Q-sense r\/\/‘r‘
Power: DC 12V 5A = |S;N 1585 2018-1-08
medoc Lid. Pxo (@

Advanced Medical Systems

1HaDekel St. POBox 423, Ramat Yishai, 3009500 Israel

CEpartner4U B.V.Esdooriaan 13,
3951 DB Maarn, the Netherlands.

12555;;%/\*

P
1D 00200 Rev.6 (01)07290103039103(11)20180108(21)1585

Figure 1: Q-Sense Label
Table 1: Equipment Labels

Equipment Label | Description

Power switch ON/OFF

Communications connector.
Date of Manufacture (YYYY-MM)

Manufacturer

Degree of protection against electric shock — Applied Part Type BF.

Warning - Connect the power cord to the power outlet, according to the
local electrical standards.

Refer to Manual

Disposal according to electronic scrap ordinance
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@

1.8 Electromagnetic immunity

The Q-Sense is intended for use in the electromagnetic environment specified below. The

Manual edition refers to current version of manufactured system

Medoc reserves the right to change specifications without prior notice,
in line with the company policy of constant product improvement

customer or the user of the Q-Sense should assure that it is used in such an environment.

Immunity test

IEC 60601

test level

Compliance

level

Electromagnetic

environment —guidance

Electrostatic
discharge (ESD)

+6 kV contact

+6 kV contact

Floors should be wood, concrete
or ceramic tile. If floors are

magnetic field
IEC 61000-4-4

+ i + i
IEC 61000-4-2 8 kv air 8 kv air covered with synthetic material,
the relative humidity should be
at least 30 %.
Power frequency 3 A/m 3 A/m Power frequency magnetic fields
(50/60 Hz) 50 & 60 Hz 50 & 60 Hz should be at levels

characteristic of a typical
location in a typical commercial
or hospital environment.

Electrical fast

+2 kV for power

+2 kV for power

Mains power quality should be
that of a typical commercial or

interruptions and
voltage variations

on power supply
input lines
IEC 61000-4-11

(>95 % dip in
uT)

for 0,5 cycle

40 % UT

(60 % dip in UT)
for 5 cycles

70 % UT

(30 % dip in UT)
for 25 cycles
<5°% UT

(>95 % dip in
uT)

for 0,5 cycle

40 % UT

(60 % dip in UT)
for 5 cycles

70 % UT

(30 % dip in UT)
for 25 cycles)
<5% UT

transient/burst supply lines supply lines hospital environment.

IEC 61000-4-4

Surge +1 kV line(s) +1 kV line(s) and | Mains power quality should be

IEC 61000-4-5 and neutral neutral that of a typical commercial or
hospital environment.

Voltage dips, short <5 % UT <5 % UT Mains power quality should be

that of a typical commercial or
hospital environment. If a dip or
an interruption of mains power
occurs, the current of the Q-
sense may be dropped off from
normal level, it may be
necessary to use uninterruptible
power supply or a battery.
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(>95 % dip in (>95 % dip in
uT) UT) for 5s

for 5s

NOTE UT is the a.c. mains voltage prior to application of the test level
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Immunity test | IEC 60601 | Compliance Electromagnetic environment -
test level level guidance
Portable and mobile RF communications
equipment should be used no closer to any
part of the Q-sense, including cables, than
the recommended separation distance
calculated from the equation applicable to
the frequency of the transmitter.
Recommended separation distance
d= [E]H'IF
1
Conducted RF 3V, 6V 3Vrms, 6V
IEC 61000-4-6 d = [%]JF
12
d = [?]v"F 80 MHz to 800 MHz
1
23
_ d =[P 800 MHzto 2,5 GHz
Radiated RF 3V/m 3V/m E1 where P
IEC 61000-4-3 is the maximum output power rating of the
transmitter in watts (W) according to the
transmitter manufacturer and d is the
recommended separation
distance in metres (m).
Field strengths from fixed RF transmitters,
3V from 3V from 0.15 :rfll(eatermmed by an electromagnetic site
0.15 to to Yi
80MHz; 8OMHzZ; _should be less than the compliance level
in each frequency range.
gvlgr(,zgn t6c:/ from 0.15 D Interference may occur in the vicinity of
) equipment marked with the following
80MHz and | 80MHz and symbol:
80% AM 80% AM
at 1kHz at 1kHz (((i)))
10V/m from | 10V/m from
80MHz 80MHz
to 2.7GHz to 2.7GHz
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NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is

affected by absorption and reflection from structures, objects and people.

* Field strengths from fixed transmitters, such as base stations for radio
(cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio
broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the
electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey
should be considered. If the measured field strength in the location in which the Q-Sense is
used exceeds the applicable RF compliance level above, the Q-Sense should be observed to
verify normal operation. If abnormal performance is observed, additional measures may be
necessary, such as reorienting or relocating the Q-Sense.

*x Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3
V/m.

Declaration - electromagnetic emissions

Emissions test Compliance Electromagnetic environment - guidance
RF emissions CISPR Groupl Class The Q-sense uses RF energy only for its internal
11 A function. Therefore, its RF emissions are very low

and are not likely to cause any interference in
nearby electronic equipment.

Harmonic emissions Class A The Q-sense is suitable for use in all
IEC establishments other than domestic, and may be
61000-3-2 used in domestic establishments and those

directly connected to the public low-voltage
power supply network that supplies buildings
used for domestic purposes, provided the
following warning is heeded: Warning: This
equipment/system is intended for use by
healthcare professionals only. This equipment/
system may cause radio interference or may
disrupt the operation of nearby equipment. It
may be necessary to take mitigation measures,
such as re-orienting or relocating the Q-sense or
shielding the location.

Voltage Fluctuations Complies
And Flicker
IEC 61000-3-3:2013
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1.9 Recommended Separation Distance between Portable
and Mobile RF Communications Equipment and Q-Sense

The Q-Sense is intended for use in an electromagnetic environment in which radiated RF

Rated maximum Separation distance according to frequency of transmitter (m)
output power of
150 kHz to 80 MHz 150 kHz to 80 MHz 80 MHz to 800 MHz | 800 MHz to 2,5 GHz
transmitter wside 1SM IS band
outsiae n anas
o . d = [i—a]«-’F
band 3
ands d = [__].,."F J - [E]JF 1
5 Va2 E1
d = [==WP
V1
0.01 0.12 0.2 0.4 1
0.1 0.37 0.64 1.3 2.6
1 1.17 2 4 8
10 3.7 6.4 13 26
100 11.7 20 40 80

For transmitters rated at a maximum output power not listed above, the recommended separation
distance d in metres (m) can be estimated using the equation applicable to the frequency of the
transmitter, where P is the maximum output power rating of the transmitter in watts (W) according
to the transmitter manufacturer.

NOTE 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected
by absorption and reflection from structures, objects and people.

disturbances are controlled. The customer or the user of the Q-Sense can help prevent
electromagnetic interference by maintaining a minimum distance between portable and mobile
RF communications equipment (transmitters) and the Q-Sense as recommended below,

according to the maximum output power of the communications equipment.
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1.10Technical Data

Medoc reserves the right to change specifications without prior notice,
in line with the company policy of constant product improvement

The table below describes the technical specifications and capabilities of the Q-Sense system.
Table 2: Q-SENSE Specifications

Parameter

Specification

Thermode Active Area

30x30 mm

Thermode temperature Range

20 - 50 °C

Heating Rate

0 -2 °C/Sec £ 10%

Cooling Rate

0-1°C/Sec = 10%

Stimulation Methods

Limits, Levels & TSL
Ramp & Hold (optional)

Baseline Thermode Temperature Range

o
Set-Point Resolution 0.1°C
. . 0.1 °C
Display Resolution
o
Repeatability +0.3°C
[e]
Absolute Accuracy £0.3°C
. Intervals*
Operating Mode *(Short pause between patients may be
required)
Minimum Inter Stimuli Interval (ISI) 2 sec
Maximum Consecutive Stimuli 10
28 - 40 °C

Programmable Parameters

Method, Adaptation Temperature, Heating Rate,
Cooling Rate, Number of Stimuli, ISI, Sound
Option, Randomize Option

Power Consumption

Communication with PC UsB
Communication with Printer Via PC
Standards IEC 60601-1; IEC 60601-1-2
CE, FDA
Approvals
Operating Voltage 12 VDC, 5A
100 - 240 VAC, 4 - 2 A, 50/60 Hz
Power Supply
Approx. 60W

31cm X 28 cm X 16¢cm (table or wall mount)

Dimensions Shipping: 53cm X 34cm X 22cm
_ Approx. 4.5 Kg
Weight Shipping: Approx. 10 Kg
Software Propriety Software Application (Included)

Computer Requirements (PC not
included)

Notebook PC (Atom CPU not supported)

At least 2 GB RAM, 6 GB Free disc space.
Windows 7/8 (32 & 64 bit), Windows XP (32bit)
sp. 3 and above.
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Parameter

Specification

Screen Resolution

1366X768 and higher

Patient Response Unit

2 buttons (Yes / No) Response Unit

Product life time

10 years

Thermode life time

1 year
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2 Overview

The Q-Sense Thermal Sensory Analyzer is a QST (Quantitative Sensory Testing) device
including advanced software package designed for clinical use and research in the field of Pain
Management.

2.1 Training

Users of Q-Sense shall have received adequate training on its safe and effective use before
attempting to work with it. Training requirements may vary from country to country. The User
shall make sure that training is received in accordance with local laws or regulations that have
the force of law. Information on training is available from your local Medoc representative.

2.2 System Description

The Q-Sense is a TSA 2001 model, which enables the user to perform various thermal test
paradigms including the method of Limits, Levels, and TSL. These test paradigms can be
utilized for a wide range of thermal QST pain measures such as thermal pain threshold and
tolerance.

Intended use: The Q-Sense is a pain management and pain research intended to be used for
the quantitative assessment of small nerve fiber dysfunctions. It measures sensory thresholds
such as the cold and warm sensation, and heat-induced pain.

2.3 Q-SENSE Thermode

The Thermode is the active component of the system which delivers the actual stimulus. The
main components of the Q-Sense Thermode include:

e Active Thermal Element - The active Thermal element is a Thermoelectric Cooler
(TEC), a peltier element, which generates a temperature gradient according to the
direction and amplitude of power (electrical current) it is given.

e Temperature Sensors (Thermistors) - The Thermistors are resistors which change their
resistance with temperature. Two thermistors are used to sense the slightest change in
temperature and deliver feedback to the temperature control unit. The temperature
control unit adjusts the power output to this feedback.

e Contact Plate - Contact plate is the external area of the Thermode which comes in
contact with the skin of the tested subject. The plate is aluminum coated for heat
dispersion.

e Cooling Elements - The cooling elements disperse heat from the TEC

For more detailed specifications of the Q-Sense please refer to the Technical Specifications in
section 1.10, page 25
2.4 Terminology

The following terms are used throughout this manual:

Table 3: Terminology

Term Description

Thermode The probe which is used to apply the thermal stimulation on the
subject's skin.

TEC Thermo Electric Cooler (TEC), a Peltier element used as the active heat
generator in the Thermode.

Rest Temperature | The initial/rest temperature of the Thermode, after system initialization
and in between tests. Also referred to as Adaptation Temperature.
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Term Description

Baseline The initial temperature the stimulus starts from

Temperature

Destination The final temperature the stimulus ends with.

Temperature

Duration Time Indicates the time the probe will remain at the destination

Trial Represents one stimulus

Sequence A set of trials with the same specifications

Test A set of sequences.

Event A specific occurrence during a test such as the onset of a stimulus,
reaching a specific temperature and etc.

LUT A Look Up Table (LUT) maps one set of values to another. A LUT is used
to map between the readings from the temperature sensors to the
actual temperature it represents.

Firmware The program embedded on the internal processor of the system

2.5 System Status

e Online: This is the Q-SENSE system full operating mode and indicates full
communication between MEDOC Main Station and Q-Sense System. While on-line the
Q-Sense system can operate in several different states as listed in the following
section.

e Demo Mode: This is a demo mode of operation. There is no communication between
the software and the Q-SENSE system. All tests performed while working in this mode
are simulated. No actual thermal stimulation is performed and there is no access to the
Q-SENSE hardware settings. The Simulator is useful for demonstration, training and
for protocol design without executing actual thermal stimulation. It is recommended to
turn off the Q-SENSE system while working in Simulator mode.

2.6 System States

System State is the active state in which the system is currently operating. System states
refer to the online status only.

The Q-SENSE active states are as follows:

e Rest Mode: The Q-SENSE system is active and ready to perform a test. The
temperature is maintained at the specified Rest Mode temperature. In this mode,
patient, program and result management are possible.

e Test Run: The Q-SENSE system is running a (predefined) test. The Thermode is
active, and the temperature varies according to the active program.

e Safe Mode: No test can be performed and safety mechanisms are activated. The
system must perform a Self-Test before resuming normal operation.

e Engineering: During Thermode Calibration the system state is set to Engineering. In
this state safety limitations are lowered and it is not allowed to run any actual tests.

e Test Initiation: The system raises the temperature from Rest Mode temperature to
Baseline level. A stabilization test is then performed, to make sure that the
temperature is maintained according to the program requirements.

e Self-Test: The system performs a Self-Test in order to check whether the connected
Thermode is functioning according to system requirements.
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e Black Box: The system has detected an error and is currently logging data in the
internal memory. The log file can be exported later for service use.

2.7 Application Methods
Method is the type of the test program. Q-SENSE supports the following methods:

e Limits: A set of predetermined stimuli is emitted, and for each stimulus, the tested
subject is required to respond (stop the stimulus) when perceiving a predefined
sensation. For more details refer to section 2.7.1.

e Levels: A set of stimuli is emitted, and for each stimulus, the subject is required to
respond. The following stimulus is calculated according to the subject's response. For
more details, refer to section 2.7.2.

e Thermal Sensory Limen (TSL): The temperature direction changes according to the
subject's response, alternating between increasing temperature and decreasing
temperature. For more details, refer to section 2.7.3.

e Ramp & Hold (optional, available with specific license): The temperature of the
stimulus is maintained for a predetermined duration.

e VAS Search (optional, available with specific license): A set of Ramp & Hold
stimuli is emitted, and for each stimulus, the subject is required to report the
perceived level of pain. The following stimulus is calculated according to the
subject's response.

section 6, Page 49, Test Procedure and Management, which addresses
the following topics: Tested subject selection, Program selection, and
Stimuli administration.

2.7.1 Limits Method

This reaction time inclusive method consists of stimuli of continuously changing intensity. With
each stimulus, when the subject perceives a predefined sensation, he/she manually stops the
stimulus.

@ Before using each of these methods, make sure you have read

The Limits method is the most widely used method for threshold determination, because it
requires the shortest test procedure of all methods, and it can measure not only pain
thresholds, but also non-painful thermal thresholds.

For detailed information refer to section 7.6.1, page 62.

2.7.2 Levels Method

In the Levels method, stimuli are increased by a predetermined initial step until the first YES
response. Stimuli then decreased by one half the initial step until a NO is given.
Subsequently, the direction changes according to the response: increase for NO and decrease
for YES. The step is halved at every direction change. The test is terminated when the step
reaches a small enough size, as pre-determined by the user. Threshold is determined by
taking the mean of last YES and the last NO. This is the shortest of all constant stimuli
methods.

A modified Levels method allows you to hold Temperature for predefined Time at destination.

For detailed information refer to section 7.6.2, page 66.

2.7.3 Thermal Sensory Limen (TSL)

The TSL is another reaction time dependent method is the detection of Thermal Sensory
Limen (T.S.L.). In this algorithm, once started, the stimulus temperature does not stop at
adaptation, rather, it continues directly from the warm threshold to the cold threshold and vice
versa. After several oscillations between warm and cold sensory thresholds, the ‘Limen’ of no
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thermal sensation is calculated as the difference between means of cold-sensation and warm-
sensation. Using the TSL method, allows the Limen or ‘no thermal sensation’ area to be
calculated.

For detailed information refer to section 7.6.3, page 70.

2.7.4 Ramp & Hold Method

In this method, the temperature rises (or falls) to a predetermined destination, at a
predetermined rate, remains there for a predetermined duration and proceeds to the next
destination.

There are two main options: Return to Baseline, and Continue to Next Destination.

“Return to Baseline” option

The diagram below shows a general view of the sequence and predefined parameters. For the
definition of each parameter, see 7.6.4, page 73.

«——Onset-to-Onset Time ——»

(&)
S A End-to-Onset
= —b -— X
I Time
S
<)) .
o Destination End of
= Temperature Duration
Iq—) — End Test
Destination Onset
temperature
Baseline

Temperature
Start Test

[
>

Time Duration i
< Before -» L > Time
Time
Sequence
kiTrial 14ﬂ<7-ma| >

A

»
o

Sequence 1

Figure 2: Ramp &Hold Sequence - Return to Baseline
Each sequence consists of a number of similar trials (one trial is also allowed).

1. The start point of each trial is called onset.
The temperature at this point (the onset point) is the Baseline Temperature defined for this
sequence.

2. From this point the temperature changes at a predefined rate, until it reaches the
predefined Destination Temperature.

3. Then, the temperature remains at the destination temperature level for the predefined
duration time. The point at the end of the duration time is called end of duration.
Setting duration time to zero produces peaks.

4. Finally, the temperature returns at the return rate, to the baseline temperature. The
temperature remains at this level for a duration that can be specified in one of two ways:
as an end-to-onset time or an onset-to-onset time.

At the start of each sequence the temperature should remain at the Baseline Temperature
level for the time given by the parameter Time Before Sequence.
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“Return to the Next Destination” option

The temperature at the End of Duration point goes directly to the Destination Temperature of
the next sequence when this option is used.

This is available only for sequences consisting of one trial.

See definition of each parameter in section 7.6.4, page 73.

perature
>

|Tem

Destination
Temperature 2

Destination

Temperature 1 Onset

|-
Ll

-—Sequence 1*k7$equence Zﬂ Time

Figure 3: Ramp & Hold Sequence - Return to Next Destination

2.7.5 VAS Search Method

In VAS Search method, first Ramp & Hold stimulus with predefined intensity and duration is
given and the subject is asked to estimate the perceived magnitude of pain. The intensity of
the next stimulus is set according to the response - increases if the reported pain rating is
lower than the desired, decreases if the reported pain rating is higher than the desired. The
step size by which the intensity of the next stimulus is changed can be predetermined during
program creation or set by the operator during the test. The VAS Search method can be used
to individually define what temperature is associated with patient's pain rating.

The temperature associated with the subject individualized rating of pain can be determined in
one of two modes - automatic and manual.

In Manual mode only the first stimulus is predefined, the intensity of the next stimulus is set
by the operator during the program run using the following window that pops up after each
trial:

@ )

Step size (°C)

CI.CIH

S >/

Figure 4: VAS Search — Manual Mode
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In this window the user selects if to increase or decrease the destination temperature of the
next trial and by how much (determined by the 'Step Size' value). There is also an option to
resume the program if the operator decides that the target pain rating was reached.

In Automatic mode the target pain rating and the step size are predetermined during program
creation and the temperature of each trial is defined according to these parameters and the
subject reported pain rating - increases by the step size value if the reported pain rating is
lower than the target and decreases by the step size value if the reported pain rating is higher
than the target.

See section 7.6.5, page 75 for full description of program details and parameters.

2.7.6 Chain Option

The chain option enables to chain any of the above methods, any number of times, in any
order.

For detailed information refer to section 7.6.6, page 77.
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3 System Components

Q-SENSE components contain the following receptacles and controls:
Table 4: Q-SENSE Connectors side Panel receptacles

# | Description Mate with

1 | Q-sense Thermode Main receptacle
Blue — power connector
Green - Sensor connector

2 | Response Unit receptacle
Use for recording patient response during test

Table 5: Connectors to power side panel

1 Power Supply
Power supply is used to connect electricity port
and to the power port in the Q-sense system.

2 | Communication USB Cable
This cable is used to connect the Q-sense com
port with a computer.

3.1 Power side Panel
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Power switch

Communication

port

Power supply

Figure 5: Power side panel

3.2 Connectors side panel

Response Unit
Q-sense Thermode receptacle

Main receptacles

Figure 6: Connectors side panel
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Q-sense connections scheme

——Electricity panel

319.D gSn:

Figure 7: Q-SENSE System Wiring Schema
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4 Setup and Installation

The Q-SENSE system installation is designed to be simple and fast. Follow the instructions
given below for selecting a location, installing and initial. Proper installation and operation of
the equipment is important for ensuring the safety of the tested subjects.

Complete and verify the entire Q-Sense setup and installation process
before the using the system

4.1 Computer Requirements

The requirements below are minimum requirements intended to be used as a guideline for
selecting a computer to use with Medoc Main Station software.

Safety Computer must comply with IEC 950 - EN 60950 - UL 60950

Processor Intel Core i3 4xxx or better
(avoid low power processors such as Atom, Pentium or Celeron)

Memory 4 GB RAM

Storage 128 GB

USB slots 2 free USB slots (3 for AlgoMed and Q-Sense CPM)

Monitor/Display | 13” (15" recommended)

Screen 1366 x 768 pixels, 96 DPI (max. 1920x1080)

Resolution

Operating Windows 7, 8, 10 32/64 bit

System (Not recommended: Windows XP service pack 3. Please see note below)
Other Microsoft Office 2007 or above (required for viewing results in excel)

The following Medoc Main Station updates will no longer support
Windows XP. Please avoid using Windows XP operating system if
possible.

The computer used for Medoc Main Station software should be dedicated
for this purpose only. Medoc takes no responsibility for any conflicts
which may occur with other programs

For optimal performance disable any other resource heavy programs
running on the same computer such as Anti-Virus, Screen Saver,
Hibernate Mode, and Network connections.
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4.2 Installation USB Content

The installation USB contains the MEDOC Main Station setup program and additional features
that are required for system normal operation, as detailed below:

1. MEDOC Main Station setup program.
Software license files.
Technical Reference Manual.

Technical Reference Service Manual.

i A wWN

Remote assistance tools.

safe place. It may be required for restoring the system configuration in
case of malfunction and/or service during remote control session by
Medoc.

@ The installation USB contains all of the unique system files. Keep it in a

4.3 Setup and Installation Main Steps
The assembly procedure consists of the following steps:
1. Selecting a location for the system. See section 4.4, page 37.

2. Connecting the Thermode and any additional accessories to the system. See section 4.5,
page 38.

3. Connecting the laptop and installing the MEDOC Main Station software. See section 04.6,
page 39.

4. Configuring the system.

See Q-Sense Technical Reference Service Manual for further details on
the system components.

4.4 Selecting a Location
An appropriate location for the Q-SENSE system should meet the following criteria:
1. The room temperature should be kept between 18°C and 24°C.

2. The Q-Sense system should not be placed in a location, which is exposed to direct sunlight
or constant vibrations, or close to heaters or air conditioners.

3. The space allocated for the system should allow enough room to perform regular system
maintenance procedures.

4. The room in which the system will be located should be quiet, allowing the tested subject
to concentrate on the examination with minimum distractions.

5. It is possible to hang the Q-Sense system using Medoc Wall Hanger. To hang the system:
Connect Medoc Wall Hanger to the specific site on the wall.

5.1.Mark the screw’s holes on the wall, and take the hanger off the wall.
5.2.Use a 6 mm drill bit to create holes on the wall in the points you marked in b section.
5.3.Insert masonry anchors to the drilled holes.

5.4. Connect the hanger by screwing the attached screws to the masonry anchors.

0 Different type of walls requires different masonry anchors.
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Figure 8: Connecting Wall hanger to the wall

4.5 Device Connections

1. Ensure that the laptop meets the requirements set by Medoc (See section 4.1, page 36).
2. Make sure that your Laptop, Q-SENSE unit and printer (optional) are all OFF.
3. Connect the system, Thermodes and accessories. See Figure 9

Q-sense connections scheme

~4—Connectors panel

Figure 9: Q-SENSE System Wiring Schema

Do NOT connect the USB cable to the Q-SENSE system before complete
installation of the MEDOC Main Station software.
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The Response Unit plug should be connected to yellow receptacle.

The Thermode green and blue plugs should be connected to the green
and blue receptacles respectively.

@ Thermode and Response Unit connectors are color coded.

grade safety approved equipment for Canada and the United States by a
recognized certification agency, which is connected to the common
protective earth of the system.

i The SIP/SOPs (signal input and outputs) must be connected to medical

Do not connect any equipment to a Q-SENSE system that has not been
specifically authorized and approved by Medoc.

DC Power Port

Figure 10: DC power port
4. Connect the Q-SENSE power supply to an AC outlet and the cable to the DC power port.

4.6 Software Installation

The installation procedure of MEDOC Main Station software can only be performed by a user
with windows system administrator rights. Without appropriate access rights, the
installation procedure may fail.

Users with previously installed versions of Medoc Main Station should review the upgrading
instructions in section 23, page 156.

Depending on the current configuration of the computer, MEDOC Main

Station installer may require the installation of additional components.
The installation procedure may take several minutes.

0 Disable any antivirus that runs on the PC before installing Medoc Main

Station.

The following instructions will guide you through the installation procedure:

1. Insert the USB drive into an available USB port on the computer
2. Open the folder to view files.

£
i
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3. Double-click Setup.exe to start software installation
4. Click Next to continue the installation.

5. Select the file location where Medoc Main Station should be installed. You can use the
location recommended by the installation. Click Next to continue.

6. Select the location of the Medoc Main Station shortcuts in the start menu. You can use the
location recommended by the installation. Click Next to continue.

7. Installing normative data - please read the agreement carefully. If you agree to the term
please choose to install normative data. Click Next to continue.

8. Privacy - please read the terms carefully. If you agree please choose to allow data
collection. You may cancel this option any time later if you choose to.

9. The installation is now in progress. Depending on your computer configuration it may take
up to several minutes.

10. After installation has completed, click Finish to close the wizard.
11. Restart your Computer.
12. Medoc Main Station software is now ready to be used.

4.7 Unit Protection

e Unplug the power supply of the Q-SENSE system from electricity if it

0 e Keep all liquids away from the Q-SENSE system.
is not to be used for a long period of time.

e Do not block airflow anywhere around the Q-SENSE system and
Thermode.

may start using the system in accordance with the operation instructions

EI_i] When all setup and installation procedures have been completed you
in section 5

4.8 Product Activation

When starting Medoc Main Station software for the first time, you will be asked to register your
new system and activate the software. Product registration and software activation is simple
and fast and it will enable you to maintain full use of Medoc Main Station software as well as:

v Warranty on your newly purchased Medoc systems

v" Access to Technical Support and Customer Service assistance
v' Software updates and new product notifications

v' Product support alerts

Please note that if you don’t activate the software within the designated time, the software will
work in demo mode only.

To complete the activation process, simply start Medoc Main Station software and follow the
instructions given in the activation wizard. If the activation wizard is not displayed when you
start Medoc Main station Software, go to the Home screen, select Options and then select
Product Registration. See Figure 11.
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If at any point during the product activation process you encounter any difficulties please
contact Medoc support at support@medoc-web.com for assistance.

Medoc Main Station

Options

Product Registration
Firmware Update
Database Utility
Preference
Language
About MEDOC Main Station...

Figure 11: Home screen product registration link
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5 Operation

The purpose of the following chapters is to specify the Q-SENSE applications and to bring in-
detail step-by-step instructions for conducting thermal stimuli.

This chapter specifies Q-SENSE behavior at start up and MEDOC Main Station basic
components.

5.1 Power up Q-SENSE System
Make sure that all communication and power cables, accessories and
Thermode are properly connected to the system!

It is not allowed to connect the Q-Sense computer to a network while
running tests with the system!

1. Connect your PC using USB cable to the COM connection, communication port, at the side
of the Q-SENSE system.

Communication port

Figure 12: Q-sense COM port

2. Power up the Q-SENSE system by using the main switch on the side of the Q-SENSE.

5.2 Starting Q-SENSE

Before initializing the Q-SENSE system, ensure that the Thermode is
connected correctly.

The Thermode should be attached to the subject’s skin only when
performing a test. Do not attach the Thermode to the subject during
system Self-Test, while programming the system or performing
maintenance.

Turn ON the Q-SENSE unit, by using the main power switch
Turn ON the laptop
Start Medoc Main Station software by double-clicking the icon

AR W N R

The Home screen is displayed showing the available devices (license dependent).
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Medoc Main Station i

Figure 13: Home Screen
5. To select Q-Sense, click on the Q-Sense image.

6. When the login screen is displayed, enter your user name and password and select "Q-
SENSE" in the "connect to" field.

@ Initial login Username and Password are both admin.

For more information on user management please refer to section 10.1.5

Medoc Main Station

Figure 14: Login Screen

7. While the software is establishing communication with the device the following screen may
be displayed:

Version: 6.1.19.1
Serial Number: 0

Supported Thermodes: Q-Sense

Figure 15: Q-Sense Splash Screen

Medoc

f
l; advanced medical systems
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8. When communication is established, the system will enter SAFE MODE and remain in this
state until completing the system Self-Test, see section 5.3 below. Make sure the
Thermode is not attached to the Subject and click on OK on the following message:

5.3 System Self-Test

Upon system start up, Q-SENSE will automatically enter SAFE MODE state. The system
performs a self-test in which system sensors are being tested. If a malfunction is detected, an
appropriate message is displayed and the system cannot operate until that malfunction is
resolved.

System self-test must be completed successfully before Q-SENSE can be used. The following
message prompting for system self-test is displayed. Make sure the Thermode is not attached
to a patient and click OK.

Figure 16: Self-Test Prompt

The system will perform a complete self-test of all enabled Thermodes according to your
system settings.

After self-test has completed successfully, Q-SENSE State will change to Rest Mode.

Make sure that Thermode is not attached to human subject before self-
test is complete.
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File View Settings Utilities Help MEdOC

User Name: Administrator
(] PATIENTS e PROGRAMS @ RESULTS

Department ® ID @ Date of Birth @ History

Department 1 8787878 11/18/2012
Department 1 12345678 11/26/1982

Current Selection

Patient Undefined
Program Undefined
Body Site Undefined

Device: Q-Sense Status:Online Com: 5  State:Rest Mode Thermode:Q-Sense-30x30 TEC:31.97 °C HS1:23.21 °C HS2:45.00 °C Fan Mode:High Safety: &

Figure 17: Q-Sense in Rest Mode

5.4 Basic Operation

As soon as the self-test is successfully completed the TEST screen is displayed:

MMS - v.6.1.19.1 S0
File View Settings Utilities Help Menu Bar MEdOC

User Name: Administrator
(0] PATIENTS () PROGRAMS @ RESULY

Select Patient Toolbar

Department & 1D @ Date of Birth @ History

L

Department 1 8787878 11/18/2012

Department 1 12345678 11/26/1982

Search Row

Current Selection .
Information Data Display

Current Selection Area

Patient Undefined
Program Undefined
Body Site Undefined

Status Line

Device: Q-Sense Siatus:Online Col Q-Sense-30x30 TEC:31.97 °C HS1:23.21 °C HS2:45.00 °C Fan Mode:High Safety: 3

Figure 18: Test Navigator — Main Menu

[Medoc

advanced medical systems
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@

The Test screen enables you to select a patient, program and body site before starting the test

procedure.

Note that the status line also indicates the type and model of the
Thermode, you are currently applying to (see red circle, above).

The TEST screen menu consists of the following components:

e Menu Bar - Perform general and software related operations

e Toolbar — Quick access to patient and program editors and saved test results

e Search Row - Filter the data for quick access to patients and programs

e Current Selection Information - Display of current selections made by user

e Data Display Area - View list of patients, programs or body sites

e Status Line - Continues real-time display of Q-SENSE status and Thermode
temperature.

The components are detailed in the following sections.

54.1

Menu Bar

The Menu bar consists of the following options:

Table 6: Menu Bar options

Menu Option Description
File Export Export selected Patient data, Program parameters or Test
Results to *.ats file format.
The *.ats file format is encoded and can be read only by
MEDOC software, enabling simple backup, export and import
options while maintaining patient confidentiality.
For detailed export and import instructions see relevant
sections in Patient, Program and Results Management
chapters.
Import Import Patients, programs and test results saved in *.ats file
format. See above description on Export.
Export to Export Tests Results to MS Excel format, for data analysis.
Excel
Print Print Test Results as a Report (enabled in the Results
screen). Refer to section 9.3 for further information.
Logoff Log off and switch users without exiting the software or
shutting down Q-SENSE.
Switch Device | Return to Home Screen and select another device or change
preferences.
Exit Exit MEDOC Main Station.
View Test Switch to Test Editor screen to perform and manage tests
from the available patient and program library.
Patients Switch to Patient Editor screen for managing Patient lists.
Programs Switch to Program Editor screen for managing programs and
protocols.
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Menu Option Description

Results Switch to Results screen to view and manage saved test
results.

Settings | Software MEDOC software related configuration and preferences.
settings
Hardware Q-SENSE system and Thermode hardware configuration and
Test settings | Test configuration and display preferences
Status Status configuration- On line\Demo.

Utilities | Department Add/Remove Departments for patient list management.
ICD 9 Add/Remove ICD 9 codes.
Normative Normative Data database and Editor.
Data
Black box System hardware and software logs
Device Initiate Q-SENSE system self-test in case safety was
recovery triggered.
Log Files View software log files
Probe Files Import or export the termode calibration details.

Help Operating Link to the Q-SENSE Technical Reference Manual
Manual
Service Link to the Q-SENSE Technical Reference Service Manual
Manual
About ... System and software information
Service Call Submit a Service Call via Medoc web site*.
FAQ FAQ on Medoc web site*.

*internet connection required

5.4.2

Toolbar

The Toolbar consists of shortcuts to the different views:

e Test Navigator — Select test parameters

e Patients View - Manage patient database

e Programs - Manage program list

e Results - View, export or print test results

5.4.3

Search Row

The Search Row allows you to filter the displayed data, in order to find the required data

quickly. To use the filter, place the cursor in the in search row, in the column you want to filter

by and start typing the beginning of the word.
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5.4.4 Current Selection Information

Current selection panel displays the currently selected items. The data may vary depending on
the current view. While in test navigator for example, the current selection will show the
currently selected patient, program, body site and enabled Thermode.

5.4.5 Data Display Area

Displays list of data which is relevant to the current screen.

5.4.6 Q-Sense Status Line

The Status bar displays important information about the status of the connected device. If the
status line is empty, MEDOC Main Station is not connected to any device. When connected to
the PATHWAY system, the status line displays the following information as described in Table
7.

Table 7: Status line parameters

Information Description

Device The device currently in use and connected to Medoc Main Station

Status The current status of the system, either Demo or On-Line.

Com Communication status between the system and the laptop. A green
indicator is displayed for ON and a red indicator for OFF.

State The state of the Temperature Control Unit. The following modes are
available: Rest, Engineering, Safe and Test run.

Thermode Indicates the type and model of the Thermode currently connected to
the system: Q-sense 30x30mm.

TEC Temperature of the Thermode.

HS1/HS2 Temperature of heat-sink (cooling element)

Fan Mode Indicates the Fan mode.

Safety Safety status. A green indicator is displayed for OK and a red indicator

for Safe Mode activation — Thermode is disconnected from input.
System remains non-functional, until malfunction is resolved.
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6 Test Procedure and Management

Starting a test procedure is only possible from the Test Navigator screen

™, MMS - v.6.1.19.1

Settings Utilities

@ I User Name:Administrator

() PROGRAMS RESULTS

D @ Last Name @ ' First Name @ Gender @ ' Date of Birth

Department 1 8787878 Doe Isabel Male 11/18/2012
Department 1 12345678 Smith John Male 11/26/1982

Test tab
highlighted

Test
Navigator

Current Selection

Patient Undefined
Program Undefined
Body Site Undefined

Device: Q-Sense Status:Online Com: 3  State:Rest Mode Thermode:Q-Sense-30x30 TEC:31.97 °C HS1:23.21 °C HS2:45.00 °C Fan Mode:High Safety: T

Figure 19: Test Management Main Screen
The stimulation procedure (test) consists of the following main steps:
¢ Select Patient - Select the tested subject’s file from the database.
e Select Program - Select the relevant program that will be used for the test.

e Select Body Site - Select the body site and its details for the current test. This step is
optional.

e Go to Test and Apply Stimuli - Perform the test

e Save/Print Test Results -Print test report and/or save test data for future reference
(This step is optional).

Make sure you are familiar with the stimulation method before you start
with the test procedure

them to concentrate on the perceived sensations throughout the full
duration of the test.

@ Inform the subjects how to operate the applicable controls, and request

The stimulation procedure steps are described in detail in the following sections.

6.1 Selecting a Patient
1. Click the Select Patient button on the Test Navigator

2. Use the Search Row (see section 5.4.3 above) to filter and sort list in order to find the
relevant patient entry.
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Click the relevant column header to sort the list.

The Patient List can be sorted according to any of the displayed fields.

) MMS - v.6.1.19.1
Y
View Settings Utilities Help \ i \-"

User Name:Administrater
PATIENTS () PROGRAMS @ RESULTS

Search
Row

D @  Last Name @  First Name ® Gengfr

Department 1 12345678 Smith John Male 11/18/1982

Current Selection

Patient Undefined

Program Undefined ShOW/Hlde
FRSMSEREREE Details Button

Device: Q-Sense Status:Online Com: %

State:Rest Mode Thermode:Q-5Sense-30x30 TEC:32.00 °C HS1:24.02 °C HS2:45.46 °C Fan Mode:High Safety: T

Figure 20: Patient Selection Menu

3. Click the patient entry to select (or double-click to select and move on to the next step).
The selected entry will be displayed in the current selection details in the left panel.

_\\

(=)
4. In order to view patient details, click on the Show Details @ button.

5. Click the Hide Details @ button to view the patients list only.

Patient details can only be viewed from the Test screen. For editing, refer
to Patient Management section (section 8, page 83).

6. Click the Clear button to clear Current Test information if required.
7. Proceed to the Selecting a Program section.

program. The “Go to Test” button will remain disabled as long as test

@ It is not possible to run a test before you select the tested subject and
details are not complete.

6.2 Selecting a Program
1. Click the Select Program button on the Test Navigator

2. Use the Search Row (see section 5.4.3 above) to filter and sort list in order to find the
relevant patient entry.
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The Program List can be sorted according to any of the displayed fields.
Click the relevant column header to sort the list.

@) MMS - v.6.1.19.1

Fi View Settings Utilities Help

ile

Select Program

@ Name

TSL Demo 7/1/2012
Levels Demo 7/1/2012
Limits CS & WS 7/1/2012

Current Selection

Patient Undefined S h OW/H i d e

Program Undefined

Body Site Undefined DEtaI|S BLIttOI’]

Device: Q-Sense Status:Online Com: 5 State:Rest Mode Thermode:Q-Sense-30x30 TEC:31.99 °C HS1:23.93 °C HS2:45.32 °C Fan Mode:High Safety: T

Figure 21: Program Selection Menu

3. Click the program entry to select (or double-click to select and move on to the next step).
The selected entry will be displayed in the current selection details in the left panel.

Py

(=)
4. In order to view patient details, click on the Show Details @ button.

The following options are available in the program details view:

Display program details.

Display program graph preview. Available on
selected methods.

View selected test instructions.

View recent program modification dates.

elc B

Program details can only be viewed from the Test screen. For editing, refer
to Program Management section (section 7, page 58).

6. Click the Hide Details button to view the program list only.

7. Click on the Clear button to clear current selection if required.
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8. Proceed to the Selecting Body Site section if you want to select site for the specific test,
or click Go to Test in order to run the test without specific body site selection.

program. The “"Go to Test” button will remain disabled as long as test

@ It is not possible to run a test before you select the tested subject and
details are not complete.

6.3 Selecting a Body Site

Selecting a tested body site is optional. A test can be initiated without selecting a body site.
1. Click on the Select Body Site button in the Test Navigator.

7\ MMS - v6080

i Settings

File View

Select Body Site

Patient  Undefined
Program  TSL Demo
Body Site Undefined

Figure 22: Select Body Site screen

2. Click on the Dermatome (Dermatomic area) you wish to use in the current test.
An enlarged view of the selected dermatome and a list of specific sites will be displayed on
the right.
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NTTMMS -v.6.0.80

View Settings

Select Body Site

« |
g Qfe=ia)
: Main Site: T3
Side: Left

 Axillary Fossa Posterior
" Back
€ Chest Wall

Patient Undefined

Program  TSL Demo
Body Site T3, Left, Axillary Fo:

WA

Figure 23: Select Body Site - Specific site selection
e s [ ) 200
3. Use the Zoom In/Out controls for a more precise selection

4. Use the Flip Image control to switch between Anterior / Posterior view (’

5. Complete the site selection by selecting one of the Specific Sites. The selected site will be
displayed in the current test details in the left side bar.

6. Click the "Go to Test" button to proceed to the test.

6.4 Running the Test
Make sure you have selected both Patient and a Program before you try
to proceed with an actual test.

[5]
1. Click the Go to Test button

The following screen is displayed:
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B saseiine [ Lower Limit
S uiriver [ voper Limit

Figure 24: Pre-Test Screen

2. Click the Start Pre-test button ( Y ).
The system performs a short pre-test, and stabilizes on the Baseline temperature.

3. After a successful pre-test, the Pre-test button is replaced by a Test Run button (<)

f At this point attach the Thermode to the tested subject.

Caution! DO NOT use any electrode paste, jell or other material on the
contact point between the Thermode and the tested subject’s skin.

Place the Thermode on the intended stimulation site so that the contact
plate makes the best possible contact with the skin, fastening it lightly
with the attached strap.

It is recommended to first fasten the strap around the area to be
stimulated and then tighten the strap by pulling it an additional 2 cm
before fastening the two ends.

4. Click the Start button ().

5. To pause the stimulation, click the pause button (=),

6. To stop the stimulation, click the stop test ( ‘!’) button.
The first click stops the test, and initiates the Finalizing test procedure (accompanied by a
message), which saves relevant information in the Black Box in case of an error.
A second click aborts the test immediately.

7. Once a test has finished, it is possible to use the mouse curser to display the exact time,
temperature and other available information at any given point.

W

8. Click on the Save button tﬂ to save the test results and stimulation data.

The system will prompt you to save the stimulation data before starting a
test or exiting the current session.
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@
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After concluding a stimulation session, always clean the Thermode
contact plate. For further details, refer to section 18, page 151.

Do NOT immerse the Thermode in any kind of liquid.

Test and Post-Test Options

Table 8: Test Run options

Print test results as a report. Refer to section 9.3 for details.

Save the stimulation data.

Display test instructions for the subject. To create or edit the default
instructions, refer to section 10.3.2.1

Play audio test instructions for the subject. To assign an audio file with
default instructions, refer to section 10.3.2.2.

Automatic zoom along the temperature axis. The temperature axis
scale expands according to the highest and lowest temperatures
displayed on screen. Button is located at the bottom left of the graph.
Alternatively, change zoom manually by using the + /- buttons.

Reset zoom to the original (default) scale. Button is located at the
bottom left of the graph.

Change the zoom along the time/trial axis, by changing the value in the
spin box at the bottom right of the graph. Use the up/down arrows or
type the value in the box.

Return back to the test screen to start a new test with or without
clearing certain test details such subject and program.

Last test results are not saved automatically.

Indicate positive subject response in Limits, Levels, and TSL protocols.

Indicates negative subject response in Limits, Levels, and TSL
protocols.

Trigger the next stimulus. Available only when the manual trigger
option is selected. The button is enabled only when the system expects
a trigger.

Edit the program locally. The edited parameters are effective only in
the specific test and the program parameters are not changed in the
data base.
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6.4.2 Temperature Graph Display

During the test, the test graph is generated and displayed on the screen. Following is an
example:

) MMS - v.6.1.19.1

Q-Sense Patient:  John Smith Sequence: 1 of 2
Limits Body Site: C5, Right, Upper Arm Lateral Trial: 20f 4
Limits CS & WS Wait: 4.0 sec

Baseline

D -
€@ wwwm| Baseline

Temperature

Device: Q-Sense Status:Online Com: T  State:Test Run Thermode:Q-Sense-30x30 TEC:31.96 °C HS1:23.78 °C HS2:45.19 °C Fan Mode:High Safety: 3

Figure 25: Real-Time Test
The+ following information is displayed:
9. Stimuli display (including CoVAS and events where applicable)
10. Current probe and program details.
11. Current sequence and trial data
12. Legend
13. Axes labels: Temperature axis on the left and CoVAS on the right (where applicable)

14, Statistics Panel: hidden by default. To view in full click on it. To keep the display
permanently open, use the pinicon () on the top right corner. Click again to hide.

15. Test and Patient Details Panel: hidden by default. To view in full click on it. To keep the

display permanently open, use the pin icon (' ) on the top right corner. Click again to
hide.

6.4.3 Test Run Keyboard Shortcuts (Hot Keys)

Keyboard shortcuts (hot keys) are available for several test functions enabling control of the
test from the keyboard. The table below describes the available options.

Table 9: Hot Keys

Button Key Action
S Can be used instead of the Stop button to finalize; then
@ stop the test.
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Button Key Action
Spacebar Can be used instead of the following buttons in sequence:
/ pre-test / run test / pause / resume test.
@,
° Y Can be used instead of the YES button.
Not available in Search method.
o N Can be used instead of the NO button.
Not available in Search method.
@ T Can be use instead of the Trigger button.
Tab Wrong Sensation option.
Available in Levels and TSL only.
Delete To Delete / Undelete a trail from statistics of a Limits

test.
Available only after test is complete and before it is saved.
Delete trail is colored in Yellow.
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7 Program Management

This chapter describes how to manage your stimulation programs. Programs can be created,
duplicated or removed from the database. Following are the detailed individual parameters for
program.

7.1 Program List
The Program screen enables you to manage programs (add, remove, edit etc.).

1. To access the program database, click the Programs button at the toolbar. The following
screen is displayed:

7 MMS - 6080

Probe  Undefined
Method  Undefined
Program  Undefined

04/07/2012
111111111 05/07/2012

| TSL Demo 01/07/2012
Designer Undefined Levels Demo

01/07/2012
Limits CS & WS 01/07/2012
tsl 12/07/2012
tz 12/07/2012
tzahitsa 12/07/2012

Figure 26: Program Management screen

2. To narrow down the displayed list use the filter row.

The more criteria you define using the filter, the shorter the list that will be
displayed.

3. To clear the filtered list, select the (All) option from the filter drop down list.

@ It is possible to change column order by drag and drop it to required place.

The following options are available in the Program Management screen:

Create a new program

Duplicate selected program
. Delete selected program

Edit selected program
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Show or Hide program preview

e Current Selection control - displays the selected program information.

e Current Thermode control - displays the Thermode that is used for the selected program.

When you open the Program Preview bar, the following screen is displayed:

File View Settings Utilities.

wwe 04/07/2012

TsL Dema 0170772012

Levels Deme. 01/07/2012
Limits €5 & WS 01/07/2012
12/07/2012

[ W (o [0

Tesl Delails

Figure 27: Program Management - Program Preview

The following options are available in the Program Preview:

Display program details.

Display program graph preview.
Available on selected methods.

View selected test instructions.

View recent program modification dates.

Program details cannot be edited from the preview screen.
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Figure 28: Program graph preview

7.2 Creating a New Program
To create a new program, perform the following procedure:

1. From the Programs screen, click the Create New Program () icon.

2.

The following dialog is displayed:

v o
> Limits W
~

Figure 29: New Program Screen

In the Probe Type drop-down list, select the Q-sense probe. The following options are
available (in accordance with your licensing agreement):

Table 10: Probe Type options

Parameter Description

Can operate with one of the following methods: Levels, Limits, TSL,
Ramp & Hold (optional, license is needed), Chain.

Q-sense

3.

4.

From the Method drop-down list, select the required stimulation method (Limits, Levels TSL
or Chain).

Type the program name.
For faster identification, it is advisable to type a meaningful name.
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5. Click OK.
The Program Details screen is displayed (see below).

7.3 Removing a Program

To remove a program from the program list:

9. Click the Remove icon (1),
10. Click Yes to the prompt.

The selected program is deleted.
7.4 Duplicate A Program

To duplicate a program from the program list:

1. Click the Duplicate icon ( © ).

2. The selected program was duplicated and given a unique name automatically (the name is
editable).

7.5 Edit A Program

To edit a program from the program list:

1. Click the Edit icon (2).

2. The selected program details screen is open and can be edited.

7.6 Program Details

The following screens enable the formation of program protocols. There are two test types:
Programmed - the Thermode temperature varies according to the program parameters.
Manual - the Thermode temperature varies according to selected accessory.

Following are sampled menus:

e Limits
e Levels
e TSL

e Ramp and Hold (optional)
e VAS Search (optional)
e Chain

The following functions are available in the program menus:

o Displays a list of the program revision history by version date and username.
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. Displays the Test Instructions Editor for editing test instructions. Refer to
section 7.8, page 80.

Returns to the previous menu.

Copies the selected record (sequence).

Not available in Levels, TSL and Chaining programs.

Pastes the copied record to the right of the selected record.

Not available in Levels, TSL and Chaining programs.

Adds a new record to the end of the current program.

Not available in Levels, TSL and Chaining programs.

Adds a new record to the left of the selected record.

Not available in Levels, TSL and Chaining programs.

Previews the program graph.

Checks program validity, and marks missing or incorrect parameters.

0B E EE E@

Saves the information displayed.

/.6.1 Limits

In this method, the system generates a number of stimuli of continuously changing intensity. With
each stimulus, when the subject perceives a predefined sensation, he/she manually stops the
stimulus. For method explanation, refer to section 2.7.1, page 29.
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Settings. Utilities Help

File View

om:  _State:Rest Mode Thermode:Q-Sense-30x30 TEC:32.00 °C_HS1:15.00 °C_HS2:10.00 °C_Fan Mode:OFF _Safety: T

Figure 30: Program Menu - Limits

@ When adding or editing programs, follow these rules:

Enter meaningful information in the Program Description section of
the screen.

Define all the parameters of a sequence for that sequence to be
valid.

If not all the sequences are displayed, use the horizontal scroll bar
to display the ones that are out of sight.

flashes next to the relevant field. A short description of the

@ Missing or incorrect parameters are identified by an € jcon that
malfunction can be displayed by holding the cursor over the

relevant ) icon.

The program menu varies according to the probe, and the method of stimuli intended for use, as
shown on the left side of the screen.

The parameters available for program creation at this stage are as follows:
Table 11: Program Details

Parameter Description

Program name The program name (editable).

Probe The probes used with this program.

Description Under Description, click the arrow ; then type free
text to describe the program.
The Description icon is indicated as active (=),
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Parameter Description
Update on The date on which the latest changes were made and saved.
Start test/End test Defines if these events are indicated by sound.

Table 12: Program Parameters

Parameter Description

Modality Four different types of sensation can be delivered to the
subject:
Warm sensation; Cold sensation; Hot pain.

Baseline (°C) Temperature from which each new stimulation sequence begins
- between 28°C to 40°C for Q-sense thermode.

Rate (°C/sec) Defines the temperature rate of increase per second, from the
baseline until the subject’s response.
Type an acceptable value: 0.1 to 2°C/Sec for Q-sense
thermode

Return Rate Defines the temperature rate of decrease per second, from the

(°C/sec) temperature at which the subject responded, down to the
baseline.

Type an acceptable value: ..0.1-1°C/sec for Q-sense thermode.

Number of Trials The number of trials in the sequence - between 1 to 100.

Randomize with next | Randomizes the next trial or sequence.

ISI Min (sec) / Variable time between trials. Type acceptable value: 2-100.
ISI Max (sec)

Standard Events Enables the system to alert you when stimulation procedure
arrives at some standard events.
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The following screen shows a test consisting of 2 sequences, each comprising of 4 trials:

[ s - vsn120

Settings Utilities.

Figure 31: A Limits Method Test

Test statistics are hidden by defaulit.
The bottom of the screen displays the total records (sequences) in the
current program.

To view the statistics details, place the cursor at the bottom end of the statistics tab and drag
it down.

Click the Tack icon at the upper right of the screen to lock or unlock the statistics display
(indicated by the circle in Figure 31).

Following are the statistic details:

[\ /|

Figure 32: Statistical analysis of results
The following information is displayed:
e Sequence index.
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Modality - WS (warm sensation); CS (cold sensation); HP (hot pain).
Number of recorded trials.

Averaged temperature - In each of the sequence trials, the subject stops the temperature
change once perceiving a predefined sensation. The temperatures at which the subject
stopped the stimulations are averaged to yield the value of the threshold.

Variance and STD (Standard Deviation) — Statistical measures of the variation in the
distribution of the temperatures that are averaged to give the threshold. Variance and
STD are calculated for a finite sample.

@ It is possible to remove a Limits Trail using the Delete button on the PC key

board. Refer to section 6.4.3, page 56 for details.

/7.6.2 Levels

In this method, the system generates a number of stimuli of changing intensity according to the

subject response. With each stimulus, the subject receives a stimulation of varying intensity which
is determined according to his previous response. Test is terminated after predefined temperature
step size and number of alternations is achieved. For a method explanation, refer to section 2.7.2,

page 29.

|

i
i

(@ s —veri70

Figure 33: Program Menu - Levels

@ When adding or editing programs, follow these rules:

Enter meaningful information in the Program Description section of the
screen.

Define all the parameters of a sequence for that sequence to be valid.

If not all the sequences are displayed, use the horizontal scroll bar to
display the ones that are out of sight.
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gﬂ Missing or incorrect parameters are identified by an €3 icon that flashes
next to the relevant field. A short description of the malfunction can be

displayed by holding the cursor over the relevant € icon.

The program menu varies according to the probe and the method of stimuli in use, as shown at
the left side of the screen.

The parameters available for program creation at this stage are as follows:
Table 13: Program Details

Parameter Description

Program Name Displays the name of the program (editable).

Probe Displays the probe that is used in this program.

Description Under Description, click the arrow [j; then type free text

to describe the program.
The Description icon is indicated as active (L& __#),

Update on The date on which the latest changes were made and saved.

Start test/End test Defines if these events are indicated by Sound.

Table 14: Program Parameters

Parameter Description

Modality Two different types of sensation can be delivered to the
subject:
Warm sensation; Cold sensation.

Baseline (°C) Temperature from which each new stimulation sequence begins
- between 28°C to 40°C for Q-sense thermode.

Trigger Defines the trigger type: Auto or Manual.

Time Before The time interval before the first trial of the current sequence

Sequence (sec) between 0 to 600 seconds.

Destination Rate Defines the temperature rate of increase or decrease per

(°C/sec) second, from the baseline until the current destination
temperature.

Type an acceptable value: ...
0.1 to 2°C/Sec for Q-sense thermode Increasing temperature or
0.1 to 1°C/Sec for Q-sense thermode Decreasing temperature
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Return Rate
(°C/sec)

Defines the temperature rate of increase or decrease per
second, from the destination temperature, down to the
baseline.

Type an acceptable value:
0.1 to 2°C/Sec for Q-sense thermode Increasing temperature or
0.1 to 1°C/Sec for Q-sense thermode Decreasing temperature

Max. Time at
Destination (sec)

Defines the maximum duration in seconds, between the time
that the temperature reached the destination and the time it
returned to the baseline. In case a YES response was detected,
the maximum time will not complete, and the temperature will
return to the baseline and continue to the next trial.
Acceptable value: 0 to 600, and according to safety
temperature - time limitations.

Min. Interval (sec) /
Max. Interval (sec)

Variable time between trials. Actual time is set randomly in
between the min. and max. values.

First Choice Step
(°C)

The initial step size that is used until the first YES response is
detected.
Acceptable value: 0.2 - 5 °C

Final Choice Step
(°C)

The fixed step size that is used in the final Turns Around
Threshold.
Acceptable value: 0.1 - 2 °C

Turns Around
Threshold

The number of turns (YES to NO or NO to YES) at the Final
Choice Step which is required to complete the test.

Number of Tests

The number of tests in a sequence - between 1 to 5.

Standard Events

Enables the system to alert you when stimulation procedure
arrives at specific standard events.

Dummy Option

Enables dummy stimulus to increase test reliability.
Dummy frequency is randomized, and it has average of 10%.

Randomize

Randomizes number of tests in order to increase sequence
reliability.

Display Message

Determine when message to test subject is displayed on
screen.

Available options:

Destination - Display message upon reaching trail destination
temperature

Return to Baseline - Display message upon trail return to
baseline temperature

No Response on
Destination

Define program behavior if subject responds after the
Maximum Time at Destination is over.

Relevant only if Maximum Time at Destination is larger than
0 and Display Message is set to Destination.

Always Accept - Accept subject’s response and continue the
test

..... Always Repeat - Ignore subject’s response and repeat the
same trial again

Manually Select - Manually select whether the response
should be accepted (press ‘A’) or ignored (press 'I’).
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The following screen shows a sequence of Levels Method Test:

L. h £ -
Statistics tab |1 AT 200

BwelineTemperaturel .
D

aasaasa \‘I.l.l.l.....l
Probe:  Q-Sense Test:  20f2 Bl e [ over it

Method:  Levels Trial: 20f2 Nl e [ oo Ui

Program: Levels Demo Returning to Baseline

E Statistics
g Sequence 1 2

Modality ws WS

Dummies Total | Yes | No 0101001010

Figure 34: A Levels Method Test

The bottom of the screen displays the total records (sequences) in

@ Test statistics are hidden by default.
the current program.

To view the statistics details, place the cursor at the bottom end of the statistics tab and drag
it down.

Click the Tack icon at the upper right of the screen to lock or unlock the statistics display
(indicated by the circle in Figure 31).
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Following are the statistic details:

[mwe

AN /)

Figure 35: Statistical Analysis of the Results

The following information is displayed:
e Sequence index.
e Used modality - WS (warm sensation); CS (cold sensation).
e Number of recorded stimuli and number of turns.

e Threshold - In test trial, the subject response is recorded. The threshold is calculated as
the average response of the last two trials.

e Dummies - The total number of dummy stimuli and their response type (Yes or No).

/7.6.3 Thermal Sensory Limen (TSL)

In this method, the system generates warm sensation and cold sensation stimuli, alternating
according to the subject response. The stimuli direction changes after each subject response. For
a method explanation, refer to section 2.7.3, page 29.

Figure 36: Program Menu - TSL
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@ When adding or editing programs, follow these rules:

Enter meaningful information in the Program Description section of
the screen.

Define all the parameters of a sequence for that sequence to be
valid.

If not all the sequences are displayed, use the horizontal scroll bar
to display the ones that are out of sight.

Missing or incorrect parameters are identified by an € icon that
flashes next to the relevant field. A short description of the
malfunction can be displayed by holding the cursor over the

relevant D icon.

The program menu varies according to the probe and the method of stimuli in use, as shown at
the left side of the screen.

The parameters available for program creation at this stage are as follows:

Table 15: Program Details

Parameter Description

Program Name Displays the name of the program (editable).

Probe Displays the probe that is used in this program.

Description Under Description, click the arrow vl; then type free text

to describe the program.
The Description icon is indicated as active (L2l ~)),

Update on The date on which the latest changes were made and saved.

Start test/End test Defines if these events are indicated by Sound.

Table 16: Program Parameters

Parameter Description

Baseline Temperature from which each new stimulation sequence begins

Temperature (°C) - between 28°C to 40°C for Q-sense thermode.

Time Before The time interval before the first trial of the current sequence.

Sequence (sec) Ranges between 0 to 600 seconds.

First stimulus Determines whether the TSL test will start with warm or cold
stimulus.
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Increase Rate Defines the temperature rate of increase per second, from the
(°C/sec) destination temperature down to the baseline.

Type an acceptable value: .0.1- 2°C/sec for Q-sense thermode.
Decrease Rate Defines the temperature rate of decrease per second, from the
(°C/sec) baseline until a response is recognized.

Type an acceptable value: .. 0.1-1°C/Sec for Q-sense thermode
Number of stimuli The number of required subject responses until test

termination.
Standard Events Enables the system to alert you when stimulation procedure

arrives at specific standard events.

The following screen shows a sequence consisting of TSL Method Test:

Probe:
I Method:  TSL Trial: 4of4 urmiter [l upper imit
Program: TSL Demo

1e3ap uaneg pue jsag

tab

I

Q-Sense Sequence: 1of 1 Bascline [ Lower Limit  [EANA Stimulus

Sequence

Warm

Cold
Difference
No. of stimuli
VAR

§TD

<

l € D «f
@0 © = JO = (i i) -
E CEEED (EEEED

0h0m:00s. OhOm:10s Oh:Om:20s. Oh:0m:30s. Oh0m:40s. OhOm:50s. Oh1m:00s. Oh:lm:10s Oh:lm:20s. Oh:lm:30s. Oh:lm:40s

Device: Q-Sense Status:Online Com: T StaterTestRun Thermode:Q-Sense-30x30 TEC:30.53°C HS1:28.43 °C HS2:27.95°C Fan Mode:High Safely: T

@

To view
it down.

Figure 37: A TSL Method Test

Test statistics are hidden by defaulit.

The bottom of the screen displays the total records (sequences) in
the current program.

the statistics details, place the cursor at the bottom end of the statistics tab and drag

Click the Tack icon at the upper right of the screen to lock or unlock the statistics display
(indicated by the circle in Figure 37).

medical systems
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Following are the statistic details:

|
Figure 38: Statistical Analysis of the Results

The following information is displayed:
e Sequence index.
e WS (warm sensation) - Threshold
e (S (cold sensation) — Threshold
e D - the absolute difference between WS and CS
e Number of recorded stimuli.

e Variance and STD (Standard Deviation) — Statistical measures of the variation in the
distribution of the temperatures that are averaged to give the threshold.

7.6.4 Ramp and Hold

In this method, the temperature rises (or falls) to a predetermined destination, at a
predetermined rate, remains there for a predetermined duration, and proceeds to the next
destination. For an example graph and an explanation of the method, refer to section 2.7.4, page
30.

Figure 39: Program Menu - Ramp and Hold

The table below describes the program parameters available for Ramp and Hold method:
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Table 17: Program Parameters

Parameter

Description

Baseline (°C)

Temperature from which each new stimulation sequence begins.

- Between 28°C to 40°C for Q-sense thermode.

Time before
sequence (sec)

The time interval before the first trial. Valid range: 0 to 600 (sec).

Trigger

Trigger mode:

e Automatic - the stimulus will start automatically after the
defined Inter Stimulus Interval (ISI).

e Manual - The operator must initiate the onset of the stimulus
after the defined ISI

Destination
temperature (°C)

Defines the destination temperature for all trials in the current
sequence. Valid range is limited by safety limitations and depends on
the duration time.

Destination rate
(°C/Sec)

Defines the temperature change rate from the baseline to destination
temperature.

0.1 to 1°C/Sec for Q-sense thermode.

Destination criterion

Temperature: The system recognizes that it has reached the target
temperature, by monitoring the temperature.

Time: The system recognizes that it has reached the target
temperature, by referring to the theoretical time that is required to
reach the destination temperature according to the selected rate.

Duration time (sec)

Defines the duration for Thermode temperature to remain at
destination temperature before returning to baseline.

Valid range: 0 to 600 (sec)

Return option

Defines whether the temperature returns to the baseline or proceeds
to the destination temperature of the next sequence. Select the
relevant option from the drop-down menu.

Note that when the “next destination” option is selected certain fields
become inactive, because they are no longer relevant (for example,
the Number of Trials turns to ‘1’).

Return Rate (°C/Sec)

Defines the temperature change rate from the destination
temperature back to baseline.

0.1 to 1°C/Sec for Q-Sense thermode

Number of Trials

The number of trials per sequence. Valid range: 1 to 100

Enable Pain Rating

Enables pain rating patient response at the end of the duration time
of each trial

Advanced options are available for configuration with specific license.
See section 25.4 page 180

Randomize with next

Randomize trials with next sequence

ISI Min (sec)

Minimum Inter-Stimulus-Interval (ISI). Valid range: 0 to 600 (sec)
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Parameter Description

ISI Max (sec) Maximum Inter-Stimulus-Interval (ISI). Valid range: 0 to 600 (sec).
Actual ISI will be randomized between min and max values.

Standard events Enables the system to alert you when stimulation procedure arrives
at specific standard events.

Note that this program is available only with special license and not
a part of basic Q-Sense configuration

7.6.5 VAS Search

In this method, the temperature of the first stimulus rises (or falls) to a predetermined
destination, at a predetermined rate, remains there for a predetermined duration, and returns to
baseline. Patient estimation of perceived magnitude of sensation is recorded for the first stimulus.
The intensity of the next stimulus is determined by patient response being higher or lower than
the desired pain rating. For a method explanation, refer to section 2.7.5 page 31.

User Name:Administrator

Figure 40: Program Editor — VAS Search
The table below describes the program parameters available for the VAS Search method:
Table 18: Program Parameters

Parameter Description

Baseline (°C) Temperature from which each new stimulation sequence begins. Valid
range:

28°C to 40°C

Trigger Trigger mode:

e Automatic - the stimulus will start automatically after the
defined Inter Stimulus Interval (ISI).
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e Manual - The operator will initiate the onset of the stimulus
after the defined ISI.

First destination
temperature (°C)

Defines the destination temperature for the first trial. Valid range is
limited by safety limitations and depends on the duration time.

Destination Rate
(°C/sec)

Defines the temperature change rate from the baseline to destination
temperature. Valid range: 0.1 to 2°C/Sec

Duration Time (sec)

Defines the duration for Thermode temperature to remain at
destination temperature before returning to baseline. Valid range: 0 to
600 (sec)

Return Rate

Defines the temperature change rate from the destination to baseline
temperature. Valid range: 0.1 to 1°C/Sec

Search Mode

Search mode:

e Automatic - starting from the second trial, the stimulus
parameters will be defined automatically by the predetermined
target pain rating and step size.

e Manual - At the end of each trial the user will define the
destination temperature of the next trial, until the desired pain
rating is reached. The user also decides when to finish the
program (i.e. when the desired pain rating is achieved). In
manual mode the 'Target Pain Rating' and 'Step size'
parameters become dimmed.

Target Pain Rating

Relevant for Automatic search mode only.

Defines the pain rating that needs to be reached. If the actual pain
rating of the current trial is lower than 'Target Pain Rating' value, the
temperature of the next trial will increase by the Step Size (see below)
and vice versa.

Valid range: 1 - 100

Step Size (°C)

Relevant for Automatic search mode only.

Determines the step size by which the temperature will increase/
decrease in every new trial. The direction of the temperature change
will depend on the difference between the target and the actual pain
ratings (see above in 'Target Pain Rating' description)

Valid range: 0.1 - 10 (°C)

Waiting time for
response (sec)

Time for which the pain rating dialog will remain on the screen waiting
for user to respond.

ISI Min (sec)

Minimum Inter-Stimulus-Interval (ISI). Valid range: 0 to 600 (sec)

ISI Max (sec)

Maximum Inter-Stimulus-Interval (ISI). Valid range: 0 to 600 (sec).
Actual ISI will be randomized between min and max values.

Standard Events

Different evens which can be indicated during the test via TTL or
Sound. See section 7.6.7

Note that this program is available only with special license and not
a part of basic Q-Sense configuration
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7.6.6 Chaining Programs

The purpose of the Chain Method is to chain several programs one after the other. The result is a
master program which runs the selected programs continuously, each program repeated by the
number of cycles defined and in order according to the indexed list.

For a method explanation, refer to section 2.7.6, Page 32.

As can be viewed in Figure 41, a program list is present for the user to choose from, when
constructing the master program.

Each sub-program is defined by the following factors:

Table 19: Chain sub program parameters

Parameter Description
Probe The probe to be used in that specific sub-program.
Method The method to be used in that specific sub-program.

Program name

A meaningful name for the specific sub-program.

Cycles

The number of cycles to be executed in that specific sub-
test.

Device: Q-Sense Status:Demo Com: :

State:Rest Mode Thermode:Q-Sense-30x30_TEC:32.00 °C_HS1:15.00 °C_HS2:10.00 °C_Fan Mode:OFF Safety: ©

Figure 41: Program Chain Editor

The program menu varies according to the probe, and the method of stimuli intended for use, as
shown on the left side of the screen.

The parameters available for program creation at this stage are as follows:

Table 20: Program Details

Column

Description

Program name

The program name (editable).
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Column Description
Probe The probes used with this program.
Description Under Description, click the arrow [ = ~|; then type free text

to describe the program.
The Description icon is indicated as active (|2 ¥]),

Update on The date on which the latest changes were made and saved.

Table 21: Program Table

Parameter Description

Program list A list of the available programs.

The serial number of the chained program. The serial number
indicates the execution order of the programs.

Probe The thermode type to be used in the chained program.

Method Test method of the chained program.

Program name Name of the chained program.

Cycles Number of times the chained program is to be performed. To
change the value, type the new one, or use the Up/Down
arrows.

The following additional functions are available:

Adds the program selected from the Program List to the chained list, below
the selected program in the chained program list.
Deletes the selected program from the chained program list.

Moves the selected program up the index (up the list).

Moves the selected program down the index (down the list).

[€] [©] [©] (€]

7.6.7 Next Sequence Definition

In Limits, TSL and Ramp & Hold protocols additional settings are available in the top part of
program editor, allowing different options for next sequence definition during the program run:

( Limits cs & WS ) (Co1j07/2012
- ~
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Figure 42: Program Editor Next Sequence Definition

Two checkboxes are available and unchecked by default:

Randomize Sequences: If this checkbox is checked the sequences order during program
run will be randomized

Manually define the next sequence: If this option is selected, the operator will receive
the following dialog window at the end of the sequence, allowing him to specify the next
sequence he would like to perform:

P - 1
(™) Specify next sequence

F# .TDesc:iptinn

2  Trials: 1, Destination Temperature (°C): 46
3  Trials: 1, Destination Temperature (°C): 47

Figure 43: Manual Next Sequence definition

Note: this option is available if the program contains more than 2 sequences; otherwise
this option will be dimmed.

If both checkboxes are unchecked the sequences order will be according to their order in
program editor (sequence number)

Proprietary 79 of 188




Q-Sense Technical Reference Manual

7.7 Standard Events

Standard Events are pre-defined events that occur during the test such as the onset of a stimulus
or reaching the destination temperature. Events are marked by a sound.

Every event is also marked on the screen during the test by an asterisk (*).

7.7.1 Standard Event Configuration
To configure standard events in the required program, follow the steps detailed below:
1. From the Programs screen, select the program you want to configure standard events for and

double click to open the program editor or click on the edit program button =
2. From the list of parameters, select the Standard Events option

ISI Min (sec)
ISI Max (sec)

Standard Events

Figure 44: Standard Events in Program Editor

3. Click the arrow on the left to open the standard event editor.
For each event that you want to configure mark the Sound column to activate.
4. Click anywhere on the screen to close the Standard Events dialog.

5. The available standard events vary according to the test method. For a list of the available
standard events according to the program type continue to the following section.

7.7.2 List of Standard Events according to Program Type
The available standard events according to program type are detailed in the table below:

Table 22: List of standard events according to program type

Program Standard Events Description
Method
Limits Onset The start of each trial in the sequence
Levels Onset The start of each trial in the sequence
TSL Destination Subject response was detected
Ramp and Hold | Onset The start of each trial in the sequence
(optional) Note: In c_urrent release that is the only Standard
Event available for Ramp and Hold.
Destination Thermode temperature reached target temperature
Note: Will be available in next release
End of duration End of duration at target temperature
Note: Will be available in next release
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7.8 Test Instructions

In some cases, the general program instructions do not fully apply to specific programs, and
unique instructions are required.

To enter test instructions, perform to the following procedure. All other (standard) tests will be
assigned the standard instructions, as entered in section 10.3.2, page 129.

11.From the program list at the left, select the required program, and double-click, or click the
Edit program details button .
The Programs menu is displayed.

12. Click the Accesses test instructions button .
The following screen is displayed:

() Use Default Instruction @ .
: . d

() Use Default Instruction

Figure 45: Test Instructions Editor
13. To edit the text instructions,

13.1. Deselect the relevant Use default instruction checkbox.
The Edit button becomes enabled.

13.2. Click the Edit button.
The text editor is displayed, displaying the standard instructions.

13.3. Edit the instructions as required, as described in section10.3.2.1, pagel129.
14.To replace the audio instructions,

14.1. Deselect the relevant Use default instruction checkbox.
The Play button becomes an enabled Browse button.

14.2. Click the Browse button.
The Audio instruction screen is displayed.

14.3. Replace the instructions file, as described in section 10.3.2.2, page 130

7.9 Import / Export Program

Program details can be imported to and exported from MEDOC Main Station using a secure and
unique format which is readable from MEDOC software only. The file extension is ats.

software versions may result in compatibility errors and loss of

@ Note that importing and exporting program data between different
data. Check database compatibility before proceeding.

In order to export Q-SENSE programs follow the procedure below:
1. Open the program list in the Programs screen.
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2. Select the programs to export. Multiple selection is possible by holding down the Ctrl and
Shift buttons on the keyboard

3. Click File > Export.
4. Select the location and name of the exported programs.

Click the Save button.
The selected programs are saved to the selected location under the selected name.

In order to import Q-SENSE programs follow the procedure below:
1. Click File > Import.
2. Browse to the location of the exported programs and select the program you want to import.

3. Click on the Open button.
The imported programs are added to your program list.

any conflicts that may arise when importing programs. For

@ MEDOC Main Station identifies and allows you to manually solve
example, programs with the same name.
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8 Patient Management
8.1 Patients List

The Patients screen enables you to manage patients (add, remove, edits etc.) and department
information.

1. To access the patient database, click the Patients button at the toolbar. The following screen
is displayed:

7 MMS - v.6080

Select a Patient

Department @ ID @ LastName @ First Name @ Gender @ DateofBith @ History (]

.

Department 1 12345678 Smith John Male 18/11/1982

Department: Undefined

Figure 46: Patients List
2. To narrow down the displayed list use the filter row.

The more criteria you define using the filter, the shorter the list
that will be displayed.

3. To clear the filtered list, select the (All) option from the filter drop down list.

In order to add / remove fields from Patient table, see
section10.1.2, page 106.

It is possible to change column order by drag and drop it to
required place.
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The following options are available in the Patient Management screen:

New Patient
Edit Patient details

Show or Hide Patient preview

Delete Patient

e Current Selection control - displays the selected program information.

When you open the Patient Preview bar, the following screen is displayed:

1 MMS - v.6.080

File View Settings Utilities

Current Selection @ LastName @ FirstName @ Gender @ DateofBith @ History. ()

First Name:  John

N
Last Name:  Smith John Male 18/11/1982 )

1D: 123

Department:

Figure 47: Patient Management - Patient details preview

‘?!V@e doc Proprietary
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@ Patient details cannot be edited from the preview control screen

8.2 Add New Patient
To add a patient to the patients list:

15. Click the Add icon ().
The Patient details screen is displayed:

(7 MMS - v6080

Figure 48: Patients Editor Screen
16. Insert all the relevant patient data.

Missing or incorrect parameters are identified by an (%] icon that
flashes next to the relevant field. A short description of the
malfunction can be displayed by holding the cursor over the

relevant ) icon.
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17.Click the Save icon ( |

18. After adding and saving all the required patients, click the Return icon ( ) to return to
the Patients list screen.

Adding a department can only be done by an administrator. See
section 8.5 page 86.

customized according to the setup defined by each user. Refer to

The information displayed on the screen (field names) can be
section 10.1.2, page 106.

8.3 Remove Patient

To remove a patient from the patients list:

190

3. Click the Delete icon (¢

4. Click Yes to the prompt.
The selected patient is deleted.

8.4 Edit Patient Details

To edit a patient from the patients list:

a
5. Click the Edit icon (=),

6. The selected patient parameters screen is open and can be edited.

8.5 Department Management
MEDOC Main Station enables you to mange (Add, Edit, Remove) your patient department.

Department management is enabled according to the authorization
level of the current user. For further information, refer to
section 10.1.5, Page 116.
1. From the Utilities menu at the top of the screen, select the Department option.
The Edit departments menu is displayed:
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&S - M
/" Edit Departments 1£73)

Department name: ® ©
= N
k Department 1 /

Department 2
Department 3

A

]

Figure 49: Edit Department Menu
2. To define a new department, click the New button; then, type the department name.

3. To rename a department, select the required department; then click the Rename button.
(Available only for System Administrators and Medical Supervisors)

4. To remove a department, select the required department; then click the Remove button. At
the prompt click the OK button.

(Available only for System Administrators and Medical Supervisors)
5. To close the dialog, click the Close button.
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8.6 ICD 9 Management
MEDOC Main Station enables you to mange (Add, Edit, Remove) your ICD 9 code.

ICD 9 management is enabled according to the authorization level
of the current user. For further information, refer to section 10.1.5,
Page 116.

1. From the Utilities menu at the top of the screen, select the ICD 9 option.
The Edit departments menu is displayed:

@

=
| 3540 Carpel Tunnel Syndro... 4 n

354.4 Causalgia of upper limb
355.0 Sciatic Neuropathy
355.1 Femoral Neuropathy
355.3 Popliteal Neuropathy
355.5 Tarsal Tunnel Syndro...
355.9 'Causalgia - RSD"

357.4 Polyneuropathy Diabetic
357.4 Polyneurapathy Othar
357.5 Toxic Neuropathy

585 Chronic Renal Failure...
722.71 Cervical IVD

722.72 Thoracic IVD

722.73 Lumbar IVD

722.81 Cervical Laminectomy...
723.1 Neck Pain

723.2 Brachial Meuritis / Rad...
724.4 Thoracic Intercostal M...
724.5 Back Pain

Figure 50: Edit ICD Menu

2. To define a new ICD 9 code, click the New button; then, type the ICD 9 code and description,
and click OK.

3. To edit an ICD 9 code, select the required code; then click the Edit button.
(Available only for System Administrators and Medical Supervisors). A code and description
window is opened. Edit the relevant fields and click OK.

4. To remove a code, select the required department; then click the Remove button. At the
prompt click the OK button.
(Available only for System Administrators and Medical Supervisors)

To close the dialog, click the Close button.

8.7 Import / Export Patient Lists

Patient details can be imported to and exported from MEDOC Main Station using a secure and
unique format which is readable from MEDOC software only. The file extension is ats.

software versions may result in compatibility errors and loss of

@ Note that importing and exporting Patient data between different
data. Check database compatibility before proceeding.
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In order to export Q-SENSE patients follow procedure below:
1. Open the patient list in the Patient screen.

2. Select the patients to export. Multiple selection is possible by holding down the Ctrl and Shift
buttons on the keyboard

Click File > Export.
4. Select the location and name of the exported patients.

5. Click the Save button.
The selected patients are saved to the selected location under the selected name.

In order to import Q-SENSE patients follow the procedure below:
1. Click File > Import.
2. Browse to the location of the exported patients and select the patients you want to import.

3. Click on the Open button.
The imported patients are added to your patients list.

solve any conflicts that may arise when importing patients. For

@ MEDOC Main Station software identifies and allows you to manually
example, patients with the same unique field.
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9 Results Management

The Results List screen lists the results of the recent test.

9.1 Results List

The Results screen enables you to manage Results (view, print, delete, etc.).

1. To access the results database, click the Results button at the toolbar. The following screen is
displayed:

File View Settings

D D D

‘uslName @ FustName @ Method @ Name ® BotySte @ Tme ® Opeator @ Comments @ @

3]
Departament Undefined Smith Limits Limits CS & WS S1, Right 01/07/2012  Manufacturer
FirstName  Undefined Smith Limits Limits CS & WS C6, Left 01/07/2012 Manufacturer
e Undefined smith Limits Limits CS & WS C6, Right 01/07/2012 Manufacturer
Undefined Smith Limits Limits CS & WS €8, Left 01/07/2012 Manufacturer

Undefined Smith imi Limits CS & WS C6, Right 01/07/2012  Manufacturer

Undefinied smith tzahitsa 6, Right 12/07/2012  Administrator

Undefined Smith tzahitsa 6. Right 12/07/2012 Administrator
Undefined

Figure 51: Results List

2. To narrow down the displayed list use the filter row.

The more criteria you define using the filter, the shorter the list
that will be displayed.

3. To clear the filtered list, select the (All) option from the filter drop down list.

In order to add / remove fields from Results table, see section
10.1.3, page 110.

It is possible to change column order by drag and drop it to
required place.

The following options are available in the results management screen:
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@ Show or Hide Results preview
or
Print Selected Results file / files

Delete selected Results file from Q-
SENSE Data Base

e Current Selection control - displays the selected program information.

When you open the Results preview bar, the following screen is displayed:

File View Settings. Utiities

© e Jo _rows O __esurs

LastName @ FistiName @ Melhod @ Name @ Body Ste

John LmitsCS& WS S1, Right 010772012

Limits CS & WS C6, Left 01/07/2012

Limits CS & WS C6, Right 01/07/2012
Limits CS & WS
Limits CS & WS

Johi
John
John
Johs

Figure 52: Result preview display

The following options are available:

View Patient details
._,&\
Display Results graph preview.
Available on selected methods.

Display test subject details preview.

Display the Result Body Site.
Available only if a Body Site was selected.

€l @
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Delete selected results file.

A Print Graph

Check Show / Hide Normative Data display.
box

9.2 Import / Export Results

Test Results can be imported to and exported from MEDOC Main Station using a secure and
unique format which is readable from MEDOC software only. The file extension is ats.
Alternatively, results can be exported as an excel file (.xls) for further analysis.

software versions may result in compatibility errors and loss of

@ Note that importing and exporting test results between different
data. Check database compatibility before proceeding.

In order to export Q-SENSE Results to .ats format follow the procedure below:
1. Open the results list in the Results screen.

2. Select the results to export. Multiple selection is possible by holding down the Ctrl and Shift
buttons on the keyboard

Click File > Export.
4. Select the location and name of the exported results.

5. Click the Save button.
The selected results are saved to the selected location under the selected name.

In order to export Q-SENSE Results to .xls format follow the procedure below:
1. Open the results list in the Results screen.

Select the results to export.

Click File > Export to Excel.

Select the location for the exported results.

Click the Save button.
The selected results are saved to the selected location.

ua A W N

The name of each result file is automatically generated according to the patient name, date, and
time of test. Chain results are exported to a new folder containing all sub-programs of the chain
program.

The resulting Excel file is divided into two tabs:
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Description: containing general patient and test data:

iy
=

1

2 Department Department 1

2 Patient smith, John

4 Probe Q-5ense

5 Model 20x30

& Method Limite

7 Program Q-sense limits test
o | Start time 18/06/2012 11:25
3 End time 18,/06,/2012 11:30
in PatientDetails
11 Department Department 1

12 |ID 2345678

13 Last Name Smith

14 |First Hame John

15 Gender Male

1% Date of Birth 18/11,/1982

17 |History

io ProgramDetals
19 Program Name J-zense limits test
20 Probe O-Sense

21 |Description

22 Updated on 168,/06/2012 11:24

r
w

24 |Body Site Main Undefined
25 |Body Site Side Undefined
26

Figure 53: Export Result File Opened In Excel - Description Tab Sample

Data: containing the detailed information of the test:

A B c D E F G H I J

1 [Timestamp [msec] _Heater [C] Tec[C] Water [C] PCB [C] covas Baseline [C] LimiterMax [C] LimiterMin [C] Events
2 15 31.99 o

El 30 3139 0 o 32 50 20
a 35 3139 0 o 32 50 20
5 55 31.39 0 o 32 50 20
& 75 31.39 0 o 32 50 20
7 80 31.99 0 o 32 50 20
e 95 31.99 0 o 32 50 20
a 1s 3199 0 0 2 s0 20
1 135 3139 0 o 32 50 20
11 155 31.39 0 o 32 50 20
12 175 31.39 0 o 32 50 20
13 150 31.99 0 o 32 50 20
14 195 31.99 0 o 32 50 20
15 21s 3199 0 0 2 s0 20
16 235 3139 0 o 32 50 20
17 245 31.39 0 o 32 50 20
18 1255 31.39 0 o 32 50 20
19 7S 31.99 0 o 32 50 20
0 295 31.99 0 o 32 50 20
21 300 3199 0 0 2 s0 20
22 315 3139 0 o 32 50 20
3 335 31.39 0 o 32 50 20
24 355 31.39 0 o 32 50 20
P 37 31.99 0 o 32 50 20
26 395 31.99 0 o 32 50 20
27 a0 3199 0 0 2 s0 20
i) 415 3139 0 o 32 50 20
3 435 31.39 0 o 32 50 20
30 455 31.39 0 o 32 50 20
31 485 31.99 0 o 32 50 20
32 475 31.99 0 o 32 50 20

Figure 54: Export Result File Opened In Excel — Data Tab Sample

In order to import Q-SENSE results, follow the procedure below:
1. Click File > Import.

2. Browse to the location of the exported results and select the results you want to import (only
for .ats format)

3. Click on the Open button.
The imported results are added to your results list.

:edoc

dvanced medical systems
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any conflicts that may rise when importing results. For example,

@ MEDOC Main Station identifies and allows you to manually solve
results with same patient name date and time.

@ Saved Results cannot be edited or modified.
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9.3 Print Results and Reports

MEDOC Main Station has a powerful Analysis and Results Report Generator that can be
customized for user needs.

Follow these steps to print your results:

1. Select the relevant results file or files from the list in the results screen.

2. Click on the Print button
The following screen is displayed:

o
7" Analysis Reports 2

© Automatic mode

Figure 55: Analysis Reports Dialog
3. Configure the Reports options according to your needs.

Press on the button of the Report Type you want to use from available options.
Only available reports type are enabled according to your results file selection.

5. Report is generated. Report may have Preview or not according to your preferences.

5.1.Print with Preview
Print Preview is displayed according to the active template and test method. Refer
to 10.1.3, page 110 for details regarding Printing Options.
Press the Print icon or select one of the export options.

5.2.Print without Preview
Report is sent to a connected printer.
Select your Printing preferences according to the available printers and print your report.

9.3.1 Analysis Report Dialog
The Analysis Report Dialog allows Q-SENSE user to generate Reports of Q-SENSE tests.
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9.3.1.1

(7 Ry Reparte g )

© Display Preview
O Print Without Preview

© Automatic mode
©O Manualmode

Figure 56: Analysis Report

Analysis Report Type

Report type defines the template and content of the report and analysis to be displayed.

©

Report template can be edited and customized according to specific
needs. Refer to section 10.1.3, page 110 for details

The following templates are available:

Table 23: Report Analysis Configuration

Report Description Restrictions
Type
Singles Print a single report for each None
selected Test Results according
to active template.
Multiple Print results statistic summary of | 1. Test Method: TSL, Levels, Limits
selected tests. 2. Selection of 2 or more result files
Bilateral Compare test statistics of same 1. Test Method: TSL, Levels, Limits
body site of two sides (Left and . ]
Right) for same body site and 2. Selection of 2 result files
test subject. 3. Identical Test Subject
4. Identical Test Program
5. Identical Main and Specific body site
6. Opposite body site sides
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Report Description Restrictions
Type
Site to Site | Compare test statistics of same 1. Test Method: TSL, Levels, Limits
g?féssjUbjeCt in two different Body 2. Selection of 2 result files
3. Identical Test Subject
4. Identical Test Program
5. Different Main and / or Specific Site
Pre / Post Compare test statistics of same 1. Test Method: TSL, Levels, Limits
Fest_subject and site, performed 2. Selection of 2 result files
in different date and time
3. Identical Test Subject
4. Identical Test Program
5. Identical Body Site
Trend Display test statistic trend vs. 1. Test Method: TSL, Levels, Limits
test date and time. 2. Selection of 2 result files or more
3. Identical Test Subject
4. Identical Test Program
5. Identical Body Site
Custom Custom report with custom Vary according to report analysis
analysis and restrictions. e Contact Medoc Service for Details.
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Reports Examples:

edoc

Print Date: 21062012 11:25; Test Dabe: 18052012 11:51

h
Lisers Adrriristrator Sense
Q-SENSE TEST REPORT

Patient Details

First Name: John Last Name: Smith Department: Department 1
L.D.: 12345678 Sex: Male Date of Birth: 15/11/1982
Histary:

Pragram Details

Probe: §-Gense - 30x30 Method: Levels Designer: Adrministrator
Program Name: Q-sense Levels
Deucription:

Body Site

Main Site: Undefined Side:Undefined Specific Site:

Test Results
[ [ Modality | Baseline | Rate | Tums | AWG |
[Te=t@# L[5S 52 | T [ 7 [Z7.1&]
Test Graph

“

»

"

»{ S g D AR

Comments

System Detalic
[t S Y Y [om—— arminn

Figure 57: Single Results Report

o
Sense
Prirk Dabe: 16/07/2012 15:05
Users Adrriristrabor

Q-SENSE TEST REPORT

Report Type: MAtiple

[ Testsubject | Program Name | Method | Body Site [Test Date |
[32Rn Sraith |Lirnits €5 & ws |Cirnits [ce. Right, 170772012
[Modality | Baseline | Rate | THals | A¥G [STD |Upper Limit| Lower Linnit]  Scale |
[Sequence 1[ws [ =2 | 1 | a4 |za.64 [0.43] | | |
[Seguence 2[CS | 32 |1 [ a4 | =23.42 |0.45] | | |
[ TestSubject | Program Name | Method | Body Site [Test Date |
John Srith Lirmits C5 & WS |Limits ‘CG‘LE&‘Ha”dpalma'The”ar Fi/n?y‘2012|
Eminence
[ [Modality [ Baseline | Rate | Trials | A¥G |STD |Upper Limit| Lower Limit [ Scale |
[fequence1]ws [ 32 [ 1 [ 4 |ce4%4 |031] 3492 | 3238 | [ F |
[Eeguence 2[cs | 32 |1 [ a | ze.ea |o.23| =zo08 | ze72 | % ] |
System Datalis
[k —— Y [— cranann

Figure 58: Multiple Results Report
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Analysis Report Examples:

Proprietary

99 of 188




Q-Sense Technical Reference Manual

edoc

Print Date: 05/08/2012 10:43

o
User: admiistrator Sense
Q-SENSE TEST REPORT

Report Type: Site to Site

Test Results

[Test subject Program Mamd Method | Body Site 1 | Date | Body site 2| Date |
o 7, Right,
John Smith '\:,'“"5 CS® | imits |Hand Dorsal  |05,08/2012|c6, Right 05/08/2012
Index
[ Modality | [ T S ]
| [ zese | ez |
[SEa 2z [ =54z | Z4es |
[DefamBs | =06 | 188 |
Test Graph
wf Cob Sers Warm Sars

®REC
A=308C

e . W
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Figure 59: Site to Site Results Report
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Figure 61: Trend Results Report
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Figure 60: Pre / Post Results Report
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Figure 63: Bilateral Results Report

9.3.1.2 Reports Configuration

Report configurations allow defining basic reports settings and display options.

The following configurations are available:

Table 24: Report Analysis Configuration

Parameter Description

Display Preview Displays report preview before sending to print.

Print Without Send report to print without a preview.

Preview

Mode Automatic Mode - automatically calculate test graph display
Manual Mode - manual settings of graph display

Number of Trails Determine how many trails to display for trail based tests.

(Manual Mode) Available for Limits and Levels.

Start Time (Manual Determine the display of test graph start time for time based

Available for TSL.
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End Time (Manual
Mode)

Determine the display of test graph end time for time based
tests.
Available for TSL.

Min. Value. (Manual
Mode)

Determine display of the test graph minimum temperature.
Available for TSL.

Max. Value. (Manual
Mode)

Determine display of the test graph maximum temperature.
Available for TSL.

Add Comments

Allow adding comments for the generated report.
Available for all report type beside Singles.
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9.3.1.3 Custom Reports Configuration

1. Save the custom report you would like to use
2. Go to Settings --> Software Settings --> Report Options tab

3. Select the required template from the left column and click Copy Template

Figure 64: Custom Report Configuration
4. A copy of the Multiple template will be added to the list (can be renamed).

5. Select the copy and click Edit Template.
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Figure 65: Custom Report Configuration

6. The report designer window will open. Go to the file menu and select “open report”. Select
the report template saved in step 1.

7. After the report template opens,
corner. There is no need to save.

close the report designer window with the X on the right

8. Back in the report options window, select the copy again and click the >> button (move

right).

Figure 66: C

9. Click Apply and close the report o
the selected type

ustom Report Configuration

ptions. This report will now replace the existing report of
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10 System Configuration

Q-SENSE system configuration is performed via three different setting menus:
1. Software Settings see section 10.1, Page 105.

2. Hardware Settings see section 10.2, Page 123.

3. Test Settings see section 10.3, Page 125.

The available system configuration options depend on user
authorization level. Refer to section 10.1.5.2, page 115.

10.1Software Settings

The software setting menu includes communication setup, user interface and preferences and user
management (authorization levels).

To access the software settings screens, from the Settings option in the menu bar; select
Software Settings.
The following screen is displayed:

Figure 67: Software Settings Dialog

The software settings menu includes the following tabs (additional tabs may be visible according
to license):

e Q-Sense

e Authorization

e Report Options
e Results Field

e Patient’s Fields

eiv:?edoc Proprietary 105 of 188
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10.1.1 Communication

The General Software Settings screen enables you to configure general software, database and
communication settings (see Figure 67 above). Configuration options are described in the table
below.

Table 25: Software Settings - General

Parameter Description

Q-Sense COM Port Set the COM port to which the Q-SENSE system is connected to
the computer:

Auto Detect - Automatically scan all available ports.
Simulator - Work in Demo Mode (MEDOC Main Station will not
connect to Q-SENSE system.

COM X - Set the specific port the Q-SENSE is connected to.
Click Connect to establish communication.

Calibration COM Port Set the COM port to which the Thermometer is connected to. This
is only required during the Automatic Calibration Procedure.

Click the Check button to test communication between the
computer and YSI thermometer. Green light indicates “pass”, and
Red indicates “fail”. For further details refer to Automatic
Calibration section in the Service Manual.

10.1.2 Patient Fields

Configure the available fields for entering patient details and determine which fields will be
displayed in the patient list. The configuration of patient fields affect all users (see section 10.1.5,
page 116), however every user can determine what fields to see when viewing the patient list.

To access Patient Field settings: from the top menu bar, select Settings and then Software
Settings.

@) MMS - v.6.3.4.5

PATIENTS : E : RESULTS -
. —— - _
- Test Settings
Select Patient
Status

Figure 68: Open Software Settings

In the Software Settings window that opens, select the Patient Fields tab.

F—
@.i Software Settings

Figure 69: Software Settings - Patient Fields tab selection

The following window is displayed:
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P .
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N History
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Figure 70: Software Settings - Patient Fields

Patient Fields consist of the following types:

Unique Fields - The selected fields are used for conclusive patient identification (more than one
can be used). Any other field can be repeated in various patients (for example, John can appear
as first name for more than one patient).

Patient Card Fields - the selected fields will be available when entering patient details.

1. Mandatory fields - these fields will be mandatory when creating a new patient card and
entering the patient details. It will not be possible to save the patient card if one of the
mandatory fields is not filled.

2. Optional fields - built in commonly used fields that can be added / removed from the patient
card.

3. User Defined fields - similar to the optional fields, these customizable fields can be added or
removed from the patient card. Rename the fields as needed.

Patient Table Fields - these are the fields will show in the patient list.
10.1.2.1 Add/Remove Patient Field

To define and add Patient Card Fields to the Patient Details dialog:
1. From the Patient Card Fields list, select the required field or add field name.
2. Click the Apply button.

To add Patient Fields to Patient Table:
1. Select field to be added from the Patient Card Fields list.
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2. Click the button to add field to Patient Table Fields.
3. Click the Apply button.

To remove Patient Fields from Patient Table:

1. Select field to be removed from the Patient Table Fields list.

2. Click the button to remove field from Patient Table Fields.

3. Click the Apply button.

To restore the default Patient Fields:
1. Click the Restore button to restore default Patient Fields.
2. Click the Apply button.
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10.1.3  Results Fields
This dialog configures the displayed fields in the Results list.

Optional Fields

v @ PatientFields v

v @ Program Fields ¥

v @ TestResults Fields v

Select All
Unselect All

C > )= (=)

Figure 71: Results Fields Configuration Screen
Table 26: Patient’s Field

[\

Parameter Description

Patient Fields Available fields from patient card
Program Fields Program related fields

Test Results Fields Test related fields

To add field to the Results Table:
1. From Optional Fields list, select (check) field to be added to Results Table.
2. Click the Apply button.

To remove field from the Results Table:
3. In Ofptional Fields list, uncheck field to be removed from Results Table.
4. Click the Apply button.

To restore the default Results Fields:
1. Click the Restore button to restore Results Fields defaults.
2. Click the Apply button.

10.1.4 Report Options

MEDOC Main Station enables to generate test reports, which contain the test results and data
according to the system definitions when the test was saved.
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Each test method has a unique report template, which is used when the user selects to print the
test results.

The Report Options tab enables users to manage their reports and edit reports templates.

© Detailed Report )

O Show Body Site |

() Simple Print )

. Singles . Singles

... Singles ... Singles
Singles b Singles
Singles - Singles

Figure 72: Report Options tab

Available Options:
Table 27: Report Options

Parameter Description

User Logo Enables and configure display of customized user Logo to
the report printouts

Report Templates Enables editing Detailed Report templates:
Options*

1. Manage Report templates data base
2. Edit custom made reports

3. Manage Active Templates list

* Available Only when Detailed Report Option is selected

10.1.4.1 Detailed Report

Detailed Report option contains all required test information and varies according to test method.

Every test method may have more than one template in the Q-SENSE data base, but only one
template is used each time when printing a report. The template type is selected by MEDOC Main
Station according to the selected test method.
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Q-SENSE user may select the active template for each method from the templates data base.
Templates can be edited and modified according to custom needs.

r:

edoc

§ advanced medical systems
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Figure 73: Detailed Report example

Proprietary

112 of 188




Q-Sense Technical Reference Manual

© Detailed Report .
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Figure 74: Detailed Report Options

The following actions are available in the Detailed Report:

Table 28: Report Options

Parameter

Description

Show Body Site

When Show Body Site option is checked, the name of the
body site that was used during a test (Main Site, Side and
Specific Site) will be displayed in the final report.

User Logo

User Logo button may be used in order to import a custom
made logo that will appear on the Q-SENSE reports.

Logo preview will appear on the right side when custom
logo is in use.

e Acceptable formats: .GIF; .JPG; .PNG; .BMP only.

Reports data base
management

Enables managing template options, Copy Template, Edit
Template, Remove template and set Active template
(>>).

Active Template is the template that is used for each test
method and type when pressing the Print button and
selecting the report type to be print.

Medoc

{§'advanced medical systems
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10.1.4.1.1Data Base Templates

The data base templates option displays the available templates from the Q-SENSE data base.
Each test method can have several templates according to the user needs.

Data base templates are characterized by the following parameters:

1. Template Name

2. Type - determine the report type the template refers to.
3. Method - determine the test method the template support.
4. Custom (checked / unchecked) - determine whether the template was made by

Manufacture or User.

The original Q-SENSE data base contains a template for each of the Q-SENSE methods. These
templates cannot be customized, edited or removed from the data base.

Editing Data Base template:

Editing a report template is an advanced action that requires basic
knowledge of data base structure and programming.

Q-SENSE enables the editing of custom made reports only. For editing a report, copy a template
from the existing data base, rename it and then edit it. The following steps describe the process of
editing a report:

1. Select a template for editing from the Data Base Template list.

2. Press the Copy Template button.
the following screen is displayed:

/" Enter report template name '

i Levels Copy

Figure 75: Custom made Report Name dialog
3. Enter a name for the new report you create and press the OK button.
4. Select the report name you have entered from the Report data base list.

5. Press Edit Template button (only custom made templates can be edited).
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6. The Report Editor screen is displayed:
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Figure 76: Report Editor Screen
7. Edit Report template according to your needs.

7.1. All report parameters may be edited.

7.2. All existing data may be accessed through the Q-SENSE data base.
8. Press the Save button when you complete editing your template.

9. Use the >> button in order to set your template as active.
Your template will replace the Active template of the selected method.

10. Use the Remove button in order to delete a template from the Q-SENSE data base (only
custom templates can be deleted).

@ A special report design can be prepared upon request by Medoc.

Setting Active Template:

1. Select the template you want to use as Active template.

2. Use the >> button in order to set selected template as active.
The selected template will replace the active template of the selected method.

r:
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10.1.5 User Management

User management enables you manage and restrict the access of specific users to certain features
of the software. For example, restrict a test operator from accidently deleting patient records.

There are four available authorization levels: Software Administrator, Biomedical Engineer,
Medical Supervisor and Operator. Refer to Table 29 for a list of allowed and restricted actions
according to user authorization level.

To access User Management panel: from the top menu bar, select Settings and then Software
Settings.

(@ MMS - v.6.3.4.5

Settings Utilities

l Select Patient ‘

Figure 77: Open Software Settings
In the Software Settings window that opens, select the Users tab.

=
| (M) Software Settings

Figure 78: Software settings users tab selection

The following window will be displayed:

Figure 79: Software Settings Users Tab
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10.1.5.1 Add\Remove Users

1. Click the “add user button” at the bottom of the user list °

r

L"' Software Qethngs

Operator

! C ) C—=)

Figure 80: Software Settings Add New User
2. Enter the following information:
2.1.User Name - this will the name the user will use when logging in to Medoc Main Station.

2.2.Last Name and First Name - these will be used for display and to identify actions
performed by this user

2.3.Role - Select a role or authorization level for this user. Note that a user can only create
users with roles equal or lower than his/hers own authorization level. Refer to Table 29 for
a list of roles and their allowed and restricted actions.

2.4.Password - choose a password for this user which will be required when logging in to
Medoc Main Station.

3. Click Apply to confirm

4. Continue to add users as needed by clicking the “add new user” button and entering the
relevant information (repeat steps 1-3).

5. Click OK to end and close the user management panel.
Medoc Recommendations:
1. Create Operator level users for each site
2. Create a Biomedical Engineer user for basic troubleshooting and
calibration at the sites if needed.

3. Change the password to the default admin user
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Figure 81: Software settings filled

To remove a user from the list, select the user and click the “delete selected user” button e

10.1.5.2 Authorization Levels

Users must be assigned to one of the following Authorization Levels or Roles, which will determine
which actions are permitted and which actions are restricted.

1. Administrator - can perform all actions. Administrators have full control over the patients,
programs and results, as well as software and hardware configuration (within the
capabilities of Medoc Main Station).

2. Biomedical Engineer - intended for a user who may handle the technical operations such
as Thermode calibration and certain hardware and software configurations. Biomedical
Engineers cannot delete patients or results.

3. Medical Supervisor - intended for a user who may handle the medical or clinical operations
such as program design. A medical supervisor will have limited access to hardware
configurations.

4. Operators - intended for user who will only be operating the system, performing common
tasks such as adding patients to the list and performing a tests. Operators cannot make
any changes to software and hardware configurations and have limited access to patient,
programs and results.

Table 29 below lists the main allowed and restricted actions for each role or Authorization Level.
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Table 29: Authorization Levels (main actions)

Screen

Function

Software
Administrator

Biomedical
Engineer

Medical
Supervisor

Operator

Patient

Add Patient

<

<

<

<

Edit Patient

Delete patient

Programs

Add Program

Edit Program

Delete Program

Duplicate Program

Program Preview

Results

View Graph

View Program
Details

ORI x I

<<l xx|x|x|x]|<

Delete

X

X

Print

<

Test

View Patient
Details

OSSOSO SRR K

D O I U I G I N B N U N N NG N

<

View Program
Details

Clear

Go to Test...

Tool bar - File

Export

Import

Export to Excel

Print

Log Off

Exit

Switch device

Tool bar -
View

Test

Patient

SIS X

OIS IS SIS S S s s s s <

OSSO SIS SO 1 <

LSS S S <
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Programs v 2 4 v
Results v v v v
Tool bar - Software
Settings Settings
Q-Sense
View v v v v
Edit v v v v
Patient’s fields
View v v v 2
Edit v v v X
Results fields
View v v v v
Edit v v v X
Report options
View v v v v
Edit v v v X
Authorization
View v v v v
Add v 4 v X
Edit v v v X
Delete v v v X
General
View v v v v
Enable thermode v v v X
Rest Mode temp. v \4 v X
% duration ... v v v X

Proprietary 120 of 188




Q-Sense Technical

Reference Manual

Screen Function Soft\{va_re Biorpedical Medica! Operator

Administrator | Engineer Supervisor

Safety

View v v v v

Edit X X X X

Thermode

View v v v v

Edit v v v X

General v 4 v X

Edit LUT tables X X X X

Manual calibration v v v X

ke v A

e, oy ]

Test settings

Instruction

Configuration

View v v v v

Edit v v v X

Body sites

View v v 2 v

Edit v v v X

status

Demo v v v v

On-line v v 4 v

Department

Add Department Vv v 4 v

lepe;ftment 4 X v X
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Rename
X X
Department 4 4

Normative data

View

Edit

Delete

< <] <] <
x| x| x| <

SIS L

Import/Export

<O 1L

Black Box

Software

<
<
<
<

View

<
<
<

Export

Q-SENSE
recovery v 4

Tool bar -
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10.2Hardware Settings

This menu enables you to set up and test the parts of the system hardware. This can include
setting up parameters such as, pulse duration and polarity; timeout limitations; detection delay,
etc.

19. From the Settings menu, select the Hardware Settings option.
The following screen is displayed:

PRU Diagnostics

Status Fan Mode

A |

Figure 82: Hardware settings — General tab
The following options are available:
Table 30: Hardware Settings Tab Sheets

Parameter Description

General For setting default hardware parameters.

Safety For displaying safety parameters.

Thermodes For setting thermode parameters and calibration.

10.2.1 General

The following options are available in the General tab:
Table 31: Hardware Settings — General tab options

Parameter Description
Reset temperature Sets the temperature in which the system remains, when it
(°C) is on but not in use.
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Parameter Description

Ramp timeout (% of | If Ramp temperature continues to be detected beyond this

duration) setting, an error message is displayed. The test is not
aborted.
Thermode enabled If the use of probe type is not possible (for example,

because it is broken) its usage can be disabled by
deselecting the checkbox.

10.2.2  Safety

The safety tab presents the software temperature time limitations which are allowed according to
the program safety regulations. In addition, is presents a list of the self-tested parts, and built-in
test (BIT) parameters.

The values in this tab can only be read, and cannot be edited.

m
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L
51 Thermistor Max. ADC a0
50 5 Safety Temperature (*C)
49 10 Thermode Max. (°C)
a7 ) H$1 max. temperature (*C)
HS2 max. temperature *C)

2

Static Fatal Mismatch (°C)
Static Warning Mismatch (*C)
ismatch (°C)

rmode (‘Clsec)
Max rate HS1 (*CISec)
Max rate HS2 "CISec)
HS Allowed Delta {°C)

Bl nloldueguxb

|
%

old Safety Table Self-test Parameters

' Te I B .I N TEC Response DAC zuw I |

femperatur .. @ Duration (s.
E) E TEC Response Temperature (*C)
19 0 TEC Response Time (sec)
Mismatch Temperature (°C)
Mismatch Ti
APID temperature (°C)
Safety check time (sec)

5
5
30

3
APID check time (sec) 3
APID temperature deviation ("C) 5
Safety temperature deviation (C) 5
APID success time (sec) 1
APID temperature margin (*C) 10

_Tm
Figure 83: Hardware settings — Safety tab
10.2.3 Thermode

The thermode tab presents all the thermode data and calibration tables. Refer to the Thermode
Management section in the Service Manual for further explanation.

Additional available functions are:
e Thermode calibration.

e Thermode management.
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Q-Sense Thermodes

& Default Thermode
@@ Q-Sense Thermode

1912012 4.27.07 PM

Load from file Save lo file Load from TCU
-
[\ <]

Figure 84: Hardware settings — Thermode tab

10.3Test Settings

The Test Settings menu includes settings and preferences which affect how the tests are
performed and displayed.

To access the test settings options, from the top menu bar, select Settings and then Test
Settings.

The following settings can be accessed from the Test Settings menu:

Test configuration- change how the test is performed and displayed

Instructions Configuration Instructions Configuration — modify text and audio test instructions for
the different program types

Body Sites - customize list of body sites.

10.3.1 Test Configuration
Control test behavior and appearance.
To access the Test Configuration settings: from the top menu bar, select Settings and then Test

Settings. In the Test Settings window that opens, select the Test Configuration tab. The
following window is displayed:
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Figure 85: Test Configuration Settings

The following options are available:

10.3.1.1 Pre-test settings
Table 32: Pre-test parameters
Parameter Description

Low temperature
margin

The bottom margin for a stabilized temperature allowed for a
successful pre-test.

High temperature
margin

The top margin for a stabilized temperature allowed for a
successful pre-test.

Success time

The stabilized temperature duration, required to render a
successful pre-test.

Maximum time

The maximal time allowed for stabilizing trials (during the pre-test
sequence).

10.3.1.2 Test Configuration
Table 33: Test configuration parameters
Parameter Description

Low destination margin

The bottom margin, above which the system declares that it has
ascended a high destination temperature.

High destination
margin

The top margin, below which the system declares that it has
descended to a low destination.
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10.3.1.3 Post Test Configuration
Table 34: Post-test parameters
Parameter Description

Post-test time

Post-test temperature stabilization is required by safety standards.
This setup is used to add time for post-test monitoring.

Add comments

When the Add Comments option is checked, a dialog box for
adding comments to the test open when a test ends. These
comments will be displayed in the final report.

Save automatically

When Save Automatically option is checked, results will be saved
automatically at the end of each test.

10.3.1.4 Test Display Configuration
Table 35: Test Display configuration
Parameter Description
Show COVAS

When checked, the COVAS output graph is displayed, with the
stimulation output graph by default. Can also be changed per test,
from the Test View screen.

Show Normative Data

When checked, the Normative Data information graph is displayed,
with the stimulation output graph by default. Can also be changed
per test, from the Test View screen.

Default trial scale

Sets the trial scale of the output graph while using the Limits
method. Can also be changed per test, in any Test View screen.

Default time scale

Sets the time scale of the output graph. Can also be changed per
test, in any Test View screen.

10.3.1.5 Temperature Scale Configuration
Table 36: Temperature Scale Configuration
Parameter Description

Temperature Scale
Range

Sets the default limits for the test graph.

Minimum Temp Unit

Sets the minimum resolution of the grid
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10.3.1.6 Temperature Limits

Table 37: Temperature Limits

Parameter

Description

Temperature Limits

Sets the minimum and maximum temperature that is allowed
during a tes. This parameter does not replace the safety limitation
of the Q-Sense; it allows limiting the stimulus temperature to a
specific range, according to unique requirements.

In case the temperature violates the temperature limits, the
following actions are taken by the Q-Sense system:

Limits Protocol: stimulus is terminated and temperature returns
to baseline temperature, and then continues to the next trial. The
terminated trial is marked with an asterisk. The terminated trial
will be taken into consideration when calculating test statistics.

TSL Protocol: the temperature does not exceed the allowed range,
according to the temperature limiter. If the temperature reaches
the limiter the direction of the stimulus is changed automatically
and the temperature is marked on the screen. The terminated
trial will be taken into consideration when calculating test
statistics.

Ramp & Hold Protocol: upon verifying a program the test
parameters are checked according to the current temperature
limiter. In case a temperature limit of a test parameter is
violated, an error message indicating the violated parameter is
displayed.
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10.3.2  Instructions Configuration

The Instructions Configuration option sets the default files that will be available to provide
information concerning the various test methods.

.-*-.
| (M) Test Settings

Instructions Configuration

Q-Sense-Limits
Q-Sense-Levels
Q-Sense-TSL

Figure 86: Instructions Configuration

Two formats are available:

e Text — a text (written) description.

e Audio - a vocal description, in wav, wma or mp3 format.
10.3.2.1 Text

To create text instructions for a test method:

20. Choose the desired test type -Limits test.

21.Click the Text button.
The following screen is displayed:
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M
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During the follow|ng test, a Thermode will be placed on your skin.

The initial Thermode temperature will be around that of your skin, and will be referred to
as the baseline temperature.
From the baseline, the temperature will change at a predefined rate, until a sensation,

which was described beferehand by the test conductor, will be perceived.

At that moment, please stop the temperature from changing any further by pressing either
button on the Response Unit. Please keep your finger on either button in order to respond
quickly.

The temperature will then return immediately to the baseline, and similar procedures shall

follow.

Please concentrate on the perceived sensations throughout the entire test.

CI— D
Figure 87: Test Instructions Editor

22. Enter the required text.

23. Click the Save button.

24. Close the window.

For editing Text instructions use the text editor.

10.3.2.2 Audio

To enter vocal instructions for a test method:

1. Create an audio file of the instructions in one of the following formats:
WAV, WMA, MP3

2. Choose the desired test type -Limits test.
Browse to the desired folder, and select the audio file.

4. Click the Open button.

7\ Budio Instruction

Figure 88: Audio save button

Click the Save button.
6. Close the window.
The following functions are available:
e Play - Plays the audio file.
e Stop - Stops the playback. Play will start from the beginning.
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e Pause - Pauses playback. Play will continue from paused place.

e Change - Reopens browser to allow replacing the current file with another one.

10.3.3  Body Site Editor

The Body Site Editor option displays the complete Body Sites list as set by the Manufacturer, and
enables the user to create a personal list of tested body sites.

The Body Site Editor is divided into two sections:
1. Manufacturer Body Sites
2. User Body Sites

e “
@J Test Settings ®

ot ot L |
)

'Hain site .YSide .TSpeciﬁc Site .TNormative D 1‘

Ti2 Right Side of Abdominal wall O rﬂ
L3 Left Gluteal
ce Left Hand Palmar Ring

Hand Dersal Ring

[N, Y

'Hain site .Tside .TSpeciﬁc Site .TNormative Data .THide [ ] q{
ra

L .

Figure 89: Body Sites Editor

10.3.3.1 Manufacturer Body Sites

The Manufacturer Body Sites section displays the complete list of body sites (Dermatomic areas)
as set by the manufacturer.

The following information is available:

Main Site - C1..C8; T1..T12; L1...L5; S1...S5.
Side - Left or Right.

Secondary Site — matches the Dermatomic areas.

Normative Data - indicates if relevant normative data is available in the Normative Data list.

2.
3.
4,
5.

Hide - enables the user to hide a site from the Body Site selection screen.

Proprietary 131 of 188




Q-Sense Technical Reference Manual

e To narrow down the displayed list use the filter row.

The following actions are available in the Manufacturer Body Sites Editor:
1. Export Body Site list to an excel file.

2. Import .ats binary Body Site list.

3. Select Hide or Display site in the Body Site selection screen by using the check box.

10.3.3.2 User Body Sites

The User Body site section enables the user to manage a customized Body Site list according to
specific needs.

The following information is available:

1. Main Site - C1...C8; T1..T12; L1...L5; S1...S5.
Side - Left or Right.

Secondary Site — matches the Dermatomic area.

Normative Data - indicates if relevant normative data is available in Normative Data list.

A

Hide - enables the user to hide a site from the Body Site selection screen.

e To narrow down the displayed list use the filter row.

The following actions are available in the User Body Sites Editor:
1. Export Body Site list to an excel file.

Import Body Site list from an excel file (Compatible files only).
Edit Body Site entry.

Delete Body Site entry.

vk wN

Select Hide or Display site in the Body Site selection screen by using the check box.
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11 System Information

The System Information menu displays the system details.
The following information is displayed:

e Software version.

e Firmware (Q-SENSE) version.

e Q-SENSE serial humber.

e Supported Thermodes (according to license).

e MEDOC contact information.

In order to see the system information:

1. From the Help menu, select the About Medoc Main Station option. The following screen is
displayed:

" D
"\ About MEDOC Main Station.., ®

Figure 90: System Information

In order to send full system information to Medoc:

1. Click the Sysinfo button. A system information file similar to the following, is created and
displayed:
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j systeminfo.td - Motepad
Eile Edit Format Miew Help

=N ECR =

L6/07/2012 12:59:44

Pathway
Advanced Thermal stimulator

version: §.0.8.0

Firmware Version: CTSA 2.0.0

Firmware Serial Mumber: 0

supported Devices: Pathway, AlgoMed, TSA-II, Q-Sense
supported Thermaodes: CHEPS, ATS, Q-Sense, TSA, WSA
Supported Modes: TSA, wsa

Supported Add-ons: Cold Temperature, Parallel mode, TTL(TSA), Covas(TsA), USE Covas(Tsa),

System information: i . . .
operating System: Microsoft windows 7 Professional wersion 6.1.7501 Service Pack 1

CPU's:
CPUD: Intel(R) CorefTM) 15 CPU 70 @ Z.80GHz

Physical memory available to windows: 3323 ME

Related products:

Microsoft MET Framework 4 Client Profile wersion 4.0.30319%
Microsoft SqL Server 2005 Express Edition (ATS) wersion 9.4, 5000, 00
microsoft .MET Framework 4 mMulti-Targeting Pack wersion 4.0.30319
microsoft .MET Framework 1.1 wersion 1.1.4322

microsoft .MET Framework 4 Extended wersion 4.0.30319

Calihrationg

m

4 | 1

Figure 91: Sysinfo File Sample

2. Save the file and send it by mail to your Medoc Service contact.
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8 advanced medical systems

134 of 188




Q-Sense Technical Reference Manual

12 The Black box (Logger)

MEDOC Main Station is installed with a “black box” or logger that records and documents software
and system information in case of error or failure. The files can be exported to excel and sent to
Medoc support in order to identify the nature and cause of any technical malfunction.

12.1Exporting the Black Box File

Follow these steps to export a black box file:

25. From the Utilities menu, select Black Box; The following screen is displayed:

= =

(71 BlackBox g

Timi . Reason @  Description

K 06/19/2012 4:26 PM Device fatal error 8021

No thermodes are enab\ed

07/12/2012 9:27 AM Device fatal error 1L Erel e T e T

2. Click OK, and resume Sel...

Figure 92: Black Box — Software
26. Select the entry to export and click Export button.
27.The Save As window is displayed.

28. Browse to the folder into which you want to save the Excel file, type the file name, and click
the Save button.
The Exporting data, please wait prompt is displayed.
You can abort the exporting process at any time, by clicking the Cancel button.

29. After Export is completed, click OK.
30.To close the Black Box window, click the OK button.
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13 Appendix A - Normative Data

Medoc Main Station includes a built-in database of Normative Data which has been collected from
various studies. In addition, you can add your own or import normative data to the database by
using the User Normative Data table. Normative data is categorized by Thermode size, age group,
gender, program type, body sites and various other parameters depending on the source.
Normative Data can be displayed in real-time during the test, or be viewed later with the test
results or in the report. Normative data is only displayed if normative data exists for the selected
body site, program parameters, and patient age and gender. The following parameters need to be
matched between the current selection and normative data for it to be displayed:

e Patient age and gender
e Program Method, modality, baseline temperature and rate
e Body site (main site, side and specific site)

New normative data can be added to the Normative Data database. If there are matching
parameters (according to the criteria above) between normative data added by the user and the
normative data provided by the manufacturer, the former will be used.

Please note that the use of the built-in Normative Data is subject to the terms and conditions
specified in the Normative Data license agreement.

13.1 Normative Data License Agreement
Use of the built-in normative data is subject to the terms and conditions as stated below.
PEASE READ THIS AGREEMENT CAREFULLY.

Medoc Ltd ("Medoc") is the sole proprietor of the software package known as the Medoc Main
Station software or "MMS software".

Medoc has created an add-on feature for the MMS software, which is a Normative Data feature
(the "ND Feature").

The built-in information contained in the ND Feature was collected from various publications and
researches, and adapted by Medoc in order to enable use in conjunction with the MMS software.

You are welcome to use the ND Feature, but you may do so only in accordance with, and subject
to, the following provisions. Use of the ND Feature by you means that you accept all the terms
and conditions of this agreement, including all limitations. You further agree that this agreement
is enforceable like any written, mutually negotiated agreement signed by you.

If you do not agree to any of the provisions of this agreement, please do not use the ND Feature.

Should you decide to install and use the ND Feature, you may do so under the following
conditions:

1. Medoc is not responsible or liable for, and does not guarantee or underwrite, the accuracy,
completeness or applicability of the information contained in the Normative Data.

2. Medoc is not responsible or liable for the use you make of the ND Feature, nor is it liable for
your conclusions from such use.

3. Medoc is not responsible or liable for any clinical diagnostics reached or treatment given based
on the Normative Data.

4. Any use of the ND Feature and the information contained therein is at the user's sole
responsibility and liability.

Should you have any questions regarding the ND Feature or this agreement, please contact Medoc
Ltd. at info@medoc-web.com
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13.2 Enable Normative Data

Normative Data is automatically enabled if you agreed to the terms and conditions during Medoc
Main Station installation (see section 4.6). However, even if you decided not to enable Normative
Data during installation, you can always enable later.

To enable normative data follow the instructions given below:

1. To open the Normative Data editor select Utilities from the top menu bar, and then select
Normative Data. The following screen is displayed:

r— :
®) Normative Data

’MethodYHOdaliterHin. AgeYHax. AgeYGem:IerY Main siteY Side YSpt—;ciﬁc SR'E:aselineY Rate YL(:u\n\!er IinI Upper IileAVG YST[} YN TThenTlode S|Y i
ra

'Metho? HodalibTHin. AleHax. AglY GendérY Main sittYSideTSpeciﬁc STBaseIineTRateTLower Ii|1'T Upper Iil'rY AVGTSTDYN T‘I‘henﬂodesTUSer NarnT
ra

Figure 93: Normative Data Editor - Enable Normative Data

2. If normative data was not enabled during MMS installation, the tables will be blank. To enable
Normative Data, click on Enable normative data (circled above). The following screen is
displayed:
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E‘,& Normative Data

’,T {#] " Install Normative Data

Figure 94: Normative Data License Agreement

3. Read the license agreement and click Apply to accept.

4. Normative Data is now enabled.

Medoc

{§'advanced medical systems
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13.3

F= =
M) Mormative Data

Hafner et al 2015 .

Lim... War... 20 20 Male L5 Left FootD.. 32 40.98 30x30
Lim... War.. 20 20 Male cs Left Forear.. 32 35.09 30x30
Lim... War... 21 21 Male L5 Left FootD.. 32 41.08 30x30
Lim... War.. 21 21 Male cs Left Forear.. 32 35.1 30x30
Lim... War... 22 22 Male L5 Left FootD.. 32 41.17 30x30
Lim... War.. 22 22 Male cs Left Forear.. 32 35.1 30x30

Linn ATTETS 22 22 BAalo = Cont D 29 Al 27 20020

Figure 95: Normative Data Editor - Learn More

13.4 Normative Data Editor

The Normative Data editor allows you to change the Normative Data source, view and export the
available built-in normative data, to import, add or modify your own normative data.

13.4.1 Selecting the Normative Data Source (Built-In Tables)

The built-in Normative Data includes several normative data tables from different sources. Each
Normative Data table is usually based on a different publication. The normative data tables may
differ in age groups, body sites and even in normative values for same gender, age group and
body site. Before using the built-in normative data select the source which best fit your
application.

To select Normative Data source table following the instructions below:

1. Open the Normative Data editor: select Utilities from the top menu bar, and then select
Normative Data.

2. Click the arrow to right of the data source name. A list will open displaying the list of
available sources. See Figure 96.
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Normative Data

Default Normative Data

-
C .‘_iRrB:aselineT Rate TL(:u\n\!er Iinr Upper IileAVG TST[) YN TThenTlode sT 1

' Method Modali
Blankenburg et al 2010
WErl| Default Normative Data . | 22 23.55  26.99 20x30

Cold.. Hafner et al 2015 |- 32 26.13 Eiloz3) g 30x30
Cold... 39 Male 51 Ri.. FootD.. 32 26.72 33.28 .. 30x30
Cold... 29 (R £2 Ri... = Maxill... 31.41 31.65 . 30x30
Cold... 69 Male 51 Left FootD.. 32 26.97 33.33 . 30x30
Cold... 59 Ri.. Hand.. 32 30.12 31.96 .. 30x30

Cold a0 i Linnoe 29 2510 29 21 20020

’Metho?r-‘lodalit\THin. AleHax. AgTGendJHain siteYSideYSpeciﬁc SYBaseIineYRateYLower Ii|1'YUpper Iin'YAVGYSTDYN T‘I‘hen‘nodesYUBer NarnY

Figure 96: Normative Data screen select source

3. Click on one of the sources in list to select. Note that changing the normative data source
will affect the display of normative data in results and in the reports. Confirm your
selection.

4. To learn more about the selected normative data source click on the “learn more” link.
Please note this link may not be available for all sources. See Figure 95.

@ Changing the normative data source affects the display of
normative data in saved test results and in generated reports.

13.4.2 Normative Data Tables

The Normative Data editor includes two separate tables:

1. Manufacturer Normative Data
2. User Normative Data

The Manufacturer Normative Data table is a ‘read-only’ table. The data cannot be edited or
modified. If needed, you can export the data, modify it and import it again as User Normative
Data or add new Normative Data to a blank table.

To open the Normative Data editor, select Utilities from the top menu bar, and then select
Normative Data. The following screen is displayed:
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Normative Data

Default Normative Data .
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Lim.. Cold.. 30 39 Male 51 Ri.. FootD.. 32 26.72 33.28 . 30x30
Lim.. Cold.. 20 29 Fe... c2 Ri...  Maxill... 32 31.41 31.65 . 30x30
Cold... 60 69 Male 51 Left FootD.. 32 26.97 33.33 . 30x30
Cold... 50 59 Fe... C6 Ri.. Hand.. 32 30.12 31.96 .. 30x30

Cold a0 F=tal = I Di Llnmoe 20 2510 29 21 2020

Figure 97: Normative Data Editor

Normative data tables include the following parameters:
Table 38: Normative Data Fields

Parameter Description Mandatory
Method The test method (Limits, Levels, ...) v
Modality The test modality (Cold Detection Threshold, Warm Detection, 4
)
Minimum Lower limit of age for which this Normative Data is applicable 4
Age
Maximum Upper limit of age for which this Normative Data is applicable v
Age
Gender The gender that this Normative Data is applicable 4
Main Site The dermatome that was used to collect the normative data. 4
Side The anatomic side that was used to collect normative data.
Specific Site | The specific body site that was used to collect the normative
data.
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Parameter Description Mandatory
Baseline The Baseline Temperature v
Rate The temperature change rate v
N The number of subjects which the normative data statistics is
based on.
AVG The average threshold of the subjects that were tested to See note
collect the specified normative data. bellow
STD The standard deviation of the threshold of a sample subject who | See note
was tested to collect the specified normative data. bellow
Upper Limit The upper limit as calculated from the normative data. See note
Upper Limit = AVG + 2xSTD. bellow
Lower Limit The lower limit as calculated from the normative data. See note
Lower Limit = AVG - 2xSTD. bellow
Thermode Thermode size used to collect this Normative Data (30x30,
Size 16x16, ...)

Note: In order to apply the normative data to test results, it is necessary to provide the upper
limit for Warm Detection Threshold and Heat Pain or the lower limit for Cold Detection Threshold
and Cold Pain. However, if these parameters are left blank, the software will calculated them from
the average and standard deviation. In this case of course, the average and standard deviation
must be provided instead.

The following operations are available:

e Export or import a list of normative data - The list of normative data can be exported or
imported from a excel file. To see the required configuration of the excel file required for
import, export the manufacturer normative data list and use the same format. The user
normative data list can also be exported and important as an *.ats file for backup.

e Add or remove data from the list of User Normative Data - add, edit or remove
normative data from the user normative data list.

To add new normative data to the list:

1. Click the New button to add a new row to the User Normative Data table

2. Enter the details for the normative data (for information about the specific parameters see
Table 38 above)

3. Click the New button to add more rows or Apply to save and apply the new data.

4. To modify existing data in the User Normative Data table, just change the values you want to
modify and click Apply to confirm changes.

To import normative data from a file:

5. Normative data can be imported only into the User Normative Data table. The data must be
arranged in a formatted table and saves as an excel file.
6. To see the correct format, export one or more records from the Manufacturer Normative Data.

To do so, select one or more records in the Manufacturer Normative Data table and click the
Export button.
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7. Open the exported file, delete the existing data except for the column headers and add your
own data in exactly the same format. Save the file as .xlIsx or .xls.

8. To import the file into the User Normative Data table, click the Import button below the User
Normative Data table and select the file you want to import.

13.5 Display of Normative Data in Tests, Results and Reports

The Normative Data can be displayed during the test, overlaid on saved test results and in the
reports. on the test screen when its parameters match the current test parameters.

The Data will be displayed only if the following test parameters match Normative
Data parameters: Method, Modality, Baseline, Rate, Main Site, Side, Specific Site,
Age Group and Gender.

e You may choose to display Normative Data as a default. Go to Settings > Test
Configuration 2 Presentation Configuration and mark the relevant check box.
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14 Appendix B - Backing Up and Restoring the
Database

The Data Base Utility enables Back-up and restore system date base.

During installation of MEDOC Main Station, a default data base is created. It is called: "Computer
name/ATS". This data base allows backup and reconstruction of the data base.

@ It is highly recommended to backup the database, on a monthly
basis.

It is highly recommended to define database accessibility via
Windows (not SQL).

To backup or restore the Q-SENSE system database, perform the following procedure:

1. From the Start menu select All Programs > Medoc > MEDOC Main Station > Database
Configuration Utility.
The following menu is displayed:

& rMs Database Utility x|

( Backup \I

B
( Restore | Owverwrites existing data !

Figure 98: Database Utility - Backup/Restore Menu

2. To backup the data base, click the Backup button.
A Saving dialog box is displayed. Use a meaningful name for better identification.

Due to Windows security, Database backup files can be saved only under:
“C:\MEDOC\DataBaseBackup”.

3. To restore a database, click the Restore buttonAt the prompt, click the OK button.
A dialog box that allows choosing the data base source will open and allow choosing the data
base you'd like to use.

4. Choose the desired data base and click the Open button.
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15 Appendix C - Accessories

The following list of accessories can be purchased from Medoc, and are listed with their Catalogue
numbers, which should be quoted when ordering a specific accessory.

Table 39: Accessories

Description Cat. No.
Standard Q-sense 30x30mm AS 00402
Thermode

This is the standard thermal probe,
which is capable of heating the skin.
Used on large body sites.

Temperature Calibration Kit AS 00406

This kit is used for checking and
calibrating the temperature calibration
of the Q-sense themodell unit, which
can be a requirement of certain grant-
funded research/study protocols. See
the service manual for operation
details.
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Description Cat. No.

Response Unit AS 00403

This unit enables the tested subject to
respond to the stimuli by pressing one
of two buttons. Depending on the
selected test, the tested subject
feedback signal terminates any
process or causes the test to continue
following a Yes/No response.

USB CoVAS - Computerized Visual | AS 00213
Analog Scale

While the Q-sense delivers a heat
stimulus to a tested subject’s body
site, the subject simultaneously
moves the CoVAS slide. The
movement of the slide is between a
predefined minimum and maximum (0
to 100), which depicts the level of
pain he/she feels.

Thermode Strap AS 00404

Proprietary 146 of 188




Q-Sense Technical Reference Manual

Description

Cat. No.

Wall Mount

Used to hang the system on a wall.

MP 00501

Power Supply

Power supply is used to connect
electricity port and to the power port
in the Q-sense system.

DT 00017

USB Cable

This cable is used to connect the Q-
sense com port with a computer.

WA 00278
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16 Appendix D - System and Module Description
16.1System Description

The Q-SENSE modular design makes it easy to troubleshoot and replace parts.
The system consists of main module:
e (Q-SENSE Accessories
For a detailed description of the accessories, refer to section 15
O Thermode (to be attached to the tested subject’s skin).
O Response Unit.
e Q-SENSE Utilities

O Laptop.
O Printer.
'- S Y, — S — S — S — — — S — S — — g—— ——
25m Q-Sense
l ‘ Thermode
Mains AC Power 4 y
100 - 240V Adaptor [—12vDC. 2m— Q-Sense Main Unit
l . Response
B = Unit

USB Communication

L+ Laptop

Figure 99: System Diagram
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17 Appendix E - Preventive and Periodical
Maintenance

This chapter describes periodic maintenance procedures.

17.1Periodical System Run and Visual Check

A periodical system run and visual examination are necessary for maintaining performance of Q-
SENSE system. The periodical run keeps all Q-SENSE accessories and subunits in operational
condition at all times. Periodical system run is required, if the system or the supplied Thermode is
not used on a regular basis, or if it has not been in use for a period of one month or more,

physical damage to system components, particularly to the

@ Visual check is required in order to make sure that there is no
Thermodes.

1. Check all accessories and Thermodes visually.
1. Check that accessories connector is intact.
2. Check that accessories body is intact.
3. Check that there is no visible damage to the Thermode heads.

2. Install all available Thermode types (Q-sense type), according to your license type, to the Q-
SENSE system.

Connect all available Q-Sense accessories (Response Unit) to the Q-SENSE system.

Connect the communication cable from the Q-Sense system to the computer running MEDOC
Main Station.

Power ON the Q-SENSE system.
Start MEDOC Main Station and ensure that communication is established.
Run the system for about 10 minutes; check for any visible malfunctions.

Run a few different test protocols such as Limits.

© ® N o U

Repeat steps 8 and 9 with all the Thermodes supplied with the system.

0 Switch Thermodes only when the Q-Sense system is turned OFF!

Remember to change calibration tables prior switching to different
Q-sense Thermode type (30x30mm).

10. If the system is not planned for use for three weeks or more, perform the following
instructions:

a. Turn OFF the Q-SENSE system through the main switch.
b. Disconnect all accessories from the Q-SENSE system, and store them in a dry place.

c. Disconnect all Thermodes from the Q-SENSE system, cover the Thermode heads with
soft cloth and store in dark dry place.
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by persons without appropriate qualifications and training and /or
using un approved spare parts may lead to serious risk of injury
and damage to the equipment as well as making the warranty void.

0 Changes, additions or maintenance to the equipment carried out

17.2Periodical Thermode Calibration

A periodical Thermode Calibration is necessary for the Q-SENSE system performance.

Perform Thermode Calibration every six months, according to the Thermode calibration service
manual.

17.3Periodical Thermode Maintenance

1. Inspect Thermode to confirm mechanical integrity and no visual damage before use on patient.

2. Replacing Thermode once a year is needed to keep System integrity. Please contact Medoc
representative in your Area for more information on Thermode replacement and warranty

extended plan.
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18 Appendix F — Cleaning and Disinfecting

Perform this procedure before initially using the Thermode and after each use, to minimize the
spread of pathogens between tested subjects.

1. Thoroughly clean the Thermode contact surface using alcohol wipes.
2. Allow to air-dry.

3. Make sure the Thermode Head Case Perforated is clean of dust.

4

Store the Thermode in a clean, dry area.
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19 Appendix G - Thermode straps assembly
instructions

1. The Q-sense Thermode strap is made out of two part - short and long

2. Insert the round end of the long strap into the slot on the Thermode side (when the hook side
is facing to you) and fold it on the loop side.

3. Insert the round end of the short strap into the slot on the other side of the Thermode (when
the hook side is facing to you) and fold it on the small loop square.

4. The Thermode is ready to use
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20 Appendix H - List of Accompanying Documents

Table 40: Q-sense Accompanying Documents

e Quick installation guide.
¢ Release Notes.
e Acceptance Test Procedure (doc)

e Packing list

e Q-sense drilling model for assembly holder

e Q-Sense Operating Manual
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21 Appendix I - Transportation and Storage
conditions

The environment conditions for Q-SENSE system transportation and storage are as follows:

e An ambient temperature range of 0 °C to +70 °C.

e A relative humidity range of 10% to 95%, including condensation.

e An atmospheric pressure range of 500 hPa to 1060 hPa.
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22 Appendix J - Environmental Conditions

The environment conditions for Q-SENSE system during standard use are as follows:

e An ambient temperature range of +18 °C to +24 °C
e A relative humidity range of 30% to 75%, including condensation

e An atmospheric pressure range of 700 hPa to 1060 hPa
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23 Appendix K - Upgrading procedure

This section regards installation for users having older version of Medoc Main Station.

1. Users having previous version of Medoc Main Station on the laptop will have the
following screen displayed:

Medoc Main Station Setup

'T Medoc Main Station is already installed.
L

Click. " QK" to remove the previous version or “Cancel” ko cancel this upgrade.

[ (o4 |[ Cancel ]

Figure 100: Previous version message

2. To upgrade version, continue with installation and click OK. The following screen will be
displayed:

Medoc Main Station Uninstall

\:{) Are yau sure you wank to completely remove Medoc Main Skation and all of its companents?

Figure 101: Removing previos version screen

3. In order to remove older versions of MMS Click YES. The following screen will be
displayed:

45 Medoc Main Station Uninstall ‘ZHEW__Q

DataB ase backup path
DataBase backup path %

Please select folder For database file backup

I Uninstall ] [ Cancel ]

Figure 102: Data Backup Path

4. Choose folder for database file backup and click Uninstall. The following screen will be
displayed:
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Medoc Main Station Uninstall

Uninstalling
Flease wait whilz Medoc Main Station is being uninstalled.

Delete file: CiiProgram FilesiMedociMedoc Main Station\DevExpress. Xtralayout.v11.2.dl

Delete file: C:\Program Files\MedociMedoc Main Station\DevExpress. xXpf.DemoBase....
Delete File: C:\Program Files\MedociMadoc Main StationtDevExpress.xpf.Docking.vl. ..
Delete file: C:\Program Files\MedociMedac Main Station\DevExpress. ¥pf.Grid.wil.2....

Delete file: C:\Program Files\Medoc\Medac Main Station\DevExpress.¥pf.Grid.«11.2.dl
Delete file: C:\Program Files\MedociMedaoc Main Station\DevExpress. Xpf.Layout.w11...
Delete file: C:\Program Files\Medoc\Medac Main Station\DevExpress.¥pf . LayoutCant.. .
Delete file: C:\Program Files\MedociMedac Main Station\DevExpress.¥pf.Ribbon.w11...
Delete file: C:\Program Files\Medoc\Medoc Main Station\DevExpress.<pf . RichEdit,»1...
Delete file: C:\Program Files\MedociMedoc Main Station\DevExpress.ktraBars.v11.2.dl
Delete file: C:\Program Files\Medac\Medar Main Station\DevExpress. XtraEditars.wil...
Delete file: C:\Program Files\Medoc\Medac Main Station\DevExpress.XtraGrid.v11.2.dl
Delete file: C:\Program Files\MedociMedaoc Main Station\DevExpress. Ktralayout.w11...

v

Figure 103: MMS Uninstall

5. When uninstall is complete the following screen will be displayed:

Medoc Main Station Uninstall E”EHZ|

Completing the Medoc Main Station
Uninstall Wizard

Medoc Main Station has been uninstalled From your
cornpuket,

Click Finish to close this wizard,

Figure 104: Uninstall Completed

6. Click finish. The following screen will be displayed:

#2 Medoc Main Station Uninstall

\5) Medoc Main Station was successfully removed From your computer,

Figure 105: MMS successfully removed

7. Click OK. To continue installation refer to Section 4.6, Page 39.
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24 Appendix L - Troubleshooting — Operator Level

The troubleshooting section describes some of the Q-SENSE most frequent Error messages and
Warnings; it helps you resolve them at operator level.

There are two types of malfunctions: Software and Hardware.

1. Software malfunctions consist of lost or damaged files that can result, for example, in missing
or incomplete tested subject information.

2. Hardware malfunctions manifest themselves either as occurrences that you become aware of,
such as Thermode not responding, or as a malfunction message displayed on the screen.

If you detect a malfunction, do the following:

1. If the malfunction you have encountered is an Error or other message refer to section 24.1.1,
page 158.

For other malfunctions, see alternative solutions in the following sections.

24.1 Numbered Software Error and Warning Messages

The design of all the Q-Sense Error messages and Warning messages is similar to this sample
message:

-
Ry

Figure 106: Error and Warning Messages Sample

The text displayed in the message box varies according to the detected malfunction.

24.1.1 Frequent Warning Messages
Table 41: Warnings

N2 | Warning Explanation

1. | The application is about to start Q-SENSE The application needs to perform a self
recovery and self test. test.

Make sure the thermode is not attached to | 1. Remove Thermode from subject.

the patient and press OK. 2. Click the OK button to start
performing a Self Test.
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N2 | Warning Explanation

2. | Q-SENSE is in Safe Mode, and must The Q-SENSE system is in Safe Mode
perform Self Test before resuming and must perform Self Test before it
operation. continues with normal operation.

vaI:)T’t YES to perform Self Test, and resume 1. Click YES if you wish to resume the
Click NO to continue in Safe Mode. Self Test.
2. Click NO if you do not want to
resume the Self Test.

3. Do you want to retry Q-SENSE recovery? The Q-SENSE is ready to retry

performing Self Test.

1. Click YES to start the Self Test.

2. Click NO to continue working in Safe
Mode.

4. | A conflict occurred while importing a user- | There is a conflict between the existing
defined field. user-defined entry in the data base and
Please resolve the conflict by performing the one you have imported.

1. Choose the local definition for this field. local definition, or imported
2. Choose the imported definition for this definition.
field.

5. | A conflict occurred while importing a user. | There is a conflict between the existing
Please resolve the conflict by performing Q-SENSE user entry in the data base and
one of the next actions: the one you have imported.

1. Choose one of the local users. 1. Select the entry you wish to keep:

2. Edit the conflicting fields in the imported local user, or imported user, or

user. modify the conflicting fields in the
imported user.

6. | A conflict occurred in department name. There is a conflict between the existing
Please resolve this conflict by performing | department name in the data base and
one of the next actions: the one you have imported.

1. Choose the local department. 1. Select the entry you wish to keep:

2. Edit the imported department name. local department, or imported
department, or modify the imported
department name.

patient. patient in the data base and the one you

Please resolve the conflict by performing have imported. _

1. Choose one of the local patients. local patient, or imported patient, or

2. Edit the conflicting fields in the imported modify the imported department

patient. name

8. | Configuration data was changed. The Q-SENSE configuration data has
Press YES to save the configuration data. been changed.

Press No to discard changes. Select one of the presented options and

Press Cancel to continue editing. continue.
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N2 | Warning Explanation

9. | Program violates safety limitations, and The program you have designed violates
cannot be saved. the Q-SENSE safety limitations and
Modify program settings, and retry saving. | therefore can not be saved to the data
Violations: base.

Sequence: ##, Temperature: ##, Actual .

time (sec): ##, Allowed time (sec): ## You have to modify the program
parameters that are stated as violation
according to the Q-SENSE safety table
before saving this program.

10. | Deleting current Thermode is not allowed. You can not delete a Thermode you are
Please set other Thermode as current and currently using from the data base.
then delete this Thermode. 1. Set another Thermode as the current

(active) Thermode.
2. Delete the Thermode you wish to
remove from data base

11. | Are you sure you want to save this You are about to save the selected
Thermode in the local database and then Thermode parameters to the Q-SENSE
set it as current? data base and set it as the current
1. Click YES to proceed. (active) Thermode of the Q-SENSE
2. Click NO to abort. system.

Select one of the presented options and
continue.

12. | Are you sure you want to replace the You are about to replace the selected
selected Thermode tables with the current | data base Thermode parameters with the
Q-SENSE tables? current (active) Q-SENSE Thermode
1. Click YES to proceed. parameters.

2. Click NO to abort. Select one of the presented options and
continue.

13. | Some of the program parameters are One or more of the program parameters
invalid. Press YES to continue editing. is not valid and must be modified.
Press NO to discard all changes. Select one of the presented options and

continue.

14. | The default instruction is not defined for No test instructions are defined for the
this program. selected method.

You can add instructions through
Settings > Test Settings -
Instructions Configuration

15. | Thermode calibration data was changed The Thermode calibration data was not
but not saved. saved.

Press O!( to §:X|t calibration and discard the Select one of the presented options and
new calibration data. )

. . . continue.
Press Cancel to continue calibration.
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N2 | Warning Explanation

16. | The configuration of the Thermode was You have changed Thermode
changed. configuration but have not saved it.
Selecting another Thermode will discard Select one of the presented options and
current changes. continue
Press YES to select another Thermode and )
discard the changes
Press NO to continue editing previous
Thermode.

17. | The imported Thermode has the same The Thermode file you try to import to
serial number as existing "Thermode the data base has same serial number as
Name" Thermode (serial number: existing data base Thermode.

#HH#HE). .

Press Yes to override the existing Sele_ct one of the presented options and
continue.

Thermode.

Press No to create a new Thermode (serial

number will be omitted).

18. | Sensor <Sensor Name>*: missing The sensor LUT can not be complete,
calibration table entries in range 10 - 48. because there are missing entries.
*<sensor hame>= TEC\HS1\HS2 Com_plete the missing entries and

continue.

19. | Sensor “Sensor Name”: The number of In order to complete calibration there
defined calibration table entries is less than | must be at least 10 entries in the
the required 10. calibration table.

Complete missing entries and continue.

20. | The number of defined calibration table When performing manual calibration, at
entries is more than the required 10, but least 10 entries are required, although
less than the recommended 20. 20 are recommended by Medoc.
e, | This message state that you have
perto P calibrated less than the recommended
missing values. number of points
2. Click NO to enable return to the P '

Hardware Settings and fill in missing You can choose to complete 20 entries or
values. let the program interpolate the missing
values.

21. | You cannot change Q-SENSE (firmware) Q-SENSE Thermode firmware can only
Thermode values directly be viewed. Only Thermode data bases

can be edited, and then set as current Q-
SENSE Thermode firmware.

22. | Destination temperature is lower than the When performing Cold EP tests there are
baseline. The interval between baseline restrictions that must be followed:
and destination must be less than 15°C. . .

. ; The interval between the baseline
Sequence 1 - The interval is 36 - 20 = S
16°C temperature and destination
temperature must be less than 15°C.
Make sure that your program complies
with these restrictions; then continue.
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N2 | Warning Explanation
23. | Destination rate is out of range: When performing a Cold EP test there
Sequence 1 - For a destination are restrictions that must be followed:
temperature of 23°C, the range must be
e Temperature change rate must be
[0.1...1]. L o
within the specified range.
Make sure that your program complies
with these restrictions and continue.
24. | Destination temperature is lower than the When performing a Cold EP test there
baseline. are restrictions that must be followed:
faer:queer[\gelz é]Return rate must be in the e The temperature return rate must be
9 B within the specified range.
Make sure that your program complies
with these restrictions and continue.
24.1.2 Frequent Error Messages
Table 42: Errors
N2 | Error Message Solution
1. The appearance of this icon, beside a

1\

configurable field or parameter, states
that the parameter value is illegal.

1. Move the cursor over the sign for
further information.
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N2 | Error Message

Solution

2. | Communication with Q-Sense was lost

1. Click OK to check if communication can
be re-established automatically, run
self-test and continue working with the
system

2. In case communication is not re-
established automatically:

1.1 Close Medoc Main Station and
switch OFF the device

1.2 Verify that the device
communication cable is connected
firmly to device and computer.

1.3 Turn ON the device and start Medoc
Main Station.

2. If steps 1 & 2 fail, contact Medoc
support

for further assistance.

Communication between Q-SENSE
system and PC was lost.

Follow the message instructions to solve
the error.

1. Click OK to check if communication
can be re-established automatically,
run self-test and continue working
with the system

2. In case communication is not re-
established automatically:

2.1 Close Medoc Main Station and
switch OFF the device

2.2 Verify that the device
communication cable is connected
firmly to device and computer.

2.3Turn ON the device and start
Medoc Main Station.

3. If steps 1 & 2 fail, contact Medoc
support

for further assistance.

3. No Thermodes are enabled. Error Code:
800D

1. Enable connected Thermode via
Hardware Settings, General tab.

2. Click OK, and resume Self Test when
prompted.

The Q-SENSE does not have any enabled
Thermodes. You must enable the
connected Thermodes via Hardware
Settings and then perform Self Test,
before continuing working with the
system.

4, Failed to recovery from Safe Mode, Q-
SENSE returns Acknowledge Code = ##.

The Q-SENSE system was unable to
complete Self Test recovery due to an
error. The Q-SENSE system is reporting
the acknowledge code that was

generated.

1. Write the Acknowledge Code number
or name.

2. Restart the Q-SENSE system and
program.

3. Continue working.

If the problem persists, contact Medoc
service and state the Acknowledge Code
number or name you experienced.
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Error Message

Solution

Failed to recovery from Safe Mode, no
response from Q-SENSE during timeout
period.

The Q-SENSE system was unable to
complete the Self Test recovery, because
the program could not connect to the
system.

1. Restart the Q-SENSE system and
program.

2. Continue working.

If the problem persists, contact Medoc
service.

MEDOC Main Station can’t locate Q-sense

device. Please check the following:

1. Verify that the correct port is selected.
Refer to the computer device manager
which port Q-Sense is connected.

2. Make sure Q-Sense device is connected
and turned ON.

MEDOC Main Station failed to connect to
the Q-Sense system.

1. Verify that the correct port is selected.
Refer to the computer device manager
which port Q-Sense is connected.

2. Make sure Q-Sense device is

connected and turned ON.If the problem

persists, contact Medoc service.

Unsupported TCU firmware version.
Firmware version: ###

MEDOC Main Station has detected that
the firmware version installed on the Q-
Sense system is not compatible with the
software.

1. Make sure the HASP is well
connected.

2. Restart Q-SENSE system and
software and try to log in

In case Restart did not solve the

problem:

1. Load the firmware, .hex file. Use the
installation CD, from which you
installed the program; or the update
folder in the Medoc FTP site, from
which you downloaded from, see
Service Manual for further
information.

User Name or Password are incorrect.

The username or password you have
entered is not the right ones.

1. Verify that you have typed the
correct user name and password.

2. Try to log in.

If the problem persists, try the admin
user name and password.
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Error Message

Solution

Command: ### failed ###.
No response from Q-SENSE.

The command failed, because no
response from the Q-SENSE was
detected.

1. Write the command name or number.

2. Restart the Q-SENSE system and
program.

3. Continue working.

If the problem persists, contact Medoc
service and state the Acknowledge Code
number or name.

10.

Command: ### failed ###.
Q-SENSE returns Acknowledge Code =
HH#H#.

The command failed as a result of the
displayed acknowledges code.

1. Write the command name or humber
and the acknowledge code.

2. Restart the Q-SENSE system and
program.

3. Continue working.

If the problem persists, contact Medoc
service and state the Acknowledge Code
number or name you experienced.

11.

The Thermode cannot be saved because its
verification failed.

One or more of the Thermode
parameters are illegal and therefore can
not be saved.

Verify that all Thermode parameters are
legal and modify the illegal ones; then
save the Thermode parameters.

12.

The following safety limitation has been
violated.

Temperature: 51 °C; Allowed time: 0
(sec). Error Code: 8002

The Q-SENSE system detected that a
safety limitation was violated during a
test run, and switched automatically to
safe mode in order to prevent any
damage.

The violated temperature and the time of
the event are displayed, together with
the error code.

1. Check that the parameters of the
program you ran are valid.

2. Check that the Thermodes are intact
and undamaged.

3. Run Self Test to verify that the Q-
SENSE system is enabled to continue
work.

If the problem persists, stop using the Q-
SENSE system and contact Medoc
service.
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N2

Error Message

Solution

13.

Static sensor mismatch. Error Code: 8003

The Q-SENSE system has detected a
mismatch between its sensors, and
therefore switched to Safe Mode in order
to prevent any damage.

1. Check that the Thermodes are intact
and undamaged.

2. Run the Self Test to verify that the
Q-SENSE system is enabled to
continue work.

3. Run Thermode calibration.

If the problem persists, stop using the Q-
SENSE system and contact Medoc
service.

14.

Static sensor mismatch. Mismatch
(difference) temperature 4 (°C). Error
Code: 8003

The Q-SENSE system has detected a
mismatch between its sensors during
static temperature measurement, and
therefore switched to Safe Mode in order
to prevent any damage.

The mismatched temperature that was
measured is as reported in the message.

1. Check that the Thermode is intact
and undamaged.

2. Run Self Test to verify that the Q-
SENSE system is enabled to continue
work.

If the problem persists, stop using the Q-
SENSE system and contact Medoc
service.

15.

Dynamic sensor mismatch.
Mismatch (difference) temperature: 10
(°C). Error Code: 8004

The Q-SENSE system has detected a
mismatch between its sensors during a
dynamic temperature change, and
therefore switched to Safe Mode in order
to prevent any damage.

The mismatched temperature that was
measured is as reported in the message.

1. Check that the Thermode is intact
and undamaged.

2. Run the Self Test to verify that the
Q-SENSE system is enabled to
continue work.

If the problem persists, stop using the Q-
SENSE system and contact Medoc
service.
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N2 | Error Message Solution

16. | Thermode TEC did not respond to The Thermode has failed to pass TEC
temperature changes. Error Code: 8007 (part of the Thermode) test during the
Make sure that the blue connector is Self Test, and therefore the Q-SENSE
connected properly has switched to Safe Mode in order to

prevent any damage.

1. Check that the Thermode is intact
and undamaged.

2. Make sure that the blue connector is
connected properly

3. Run Self Test to verify that the Q-
SENSE system is enabled to continue
work.

4. If self Test fails, Restart system and
software and retry.

If the problem persists, stop using the Q-
SENSE system and contact Medoc

service.
17. | TEC sensor is shorted or disconnected. The Q-SENSE system has detected that
Error Code: 800A the TEC (part of the Thermode) sensor is

shorted or not connected, and therefore
switched to Safe Mode in order to
prevent any damage.

1. Check that the Thermode is intact
and undamaged.

2. Run Self Test to verify that the Q-
SENSE system is enabled to continue
work.

If the problem persists, stop using the Q-
SENSE system and contact Medoc
service.

18. | Empty command buffer. Error Code: 400C | An error has occurred in the Q-SENSE
processor during run time.

1. Click OK and continue working as
usual.

If the problem persists, send the
corresponding error code to the Medoc
service team.
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N2

Error Message

Solution

19.

Time mark missed. Error Code: 400D

An error has occurred in the Q-SENSE
processor during run time.

1. Click OK and continue working as
usual.

2. Restart the Q-SENSE system and
software.

If the problem persists, send the
corresponding error code to the Medoc
service team.

20.

Sample buffer full. Error Code: 2001

An error occurred in the Q-SENSE
processor during run time.

1. Click OK and continue working as
usual.

If the problem persists, send the
corresponding error code to the Medoc
service team.

21.

Finite ramp by temperature timeout.
Thermode temperature: 35 (°C). Error
Code: 2002

The Q-SENSE system was unable to
complete the requested command in the
allowed time, and has therefore switched
to Safe Mode in order to prevent any
damage.

1. Check that the Fan mode is according
to requirement.

2. Run Self Test to verify that the Q-
SENSE system is enabled to continue
work.

If the problem persists, stop using the Q-
SENSE system and contact Medoc
service.

22.

Safety cold duration limit violation.
Temperature level: 20 (°C), Time entry:
10(sec). Error Code: 800E

The Q-SENSE system has detected that
the safety limitation was violated, and
therefore switched to Safe Mode in order
to prevent any damage.

1. Make sure that the program you are
trying to run complies with the safety
limitations.

2. Run Self Test to verify that the Q-
SENSE system is enabled to continue
work.

23.

System could not establish communication!
Retry: The system will retry to establish
communication.

Cancel: Continue working without
connecting to device.

The program was unable to establish
communication with the Q-SENSE
system.

Select one of the presented options and
continue.
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N2 | Error Message Solution

24. | The thermometer does not respond. Automatic calibration had failed, because
1. Check that the thermometer is turned the program could not communicate with
on. the thermometer.
2. Check that the thermometer is Follow the displayed instructions, and
connected to the correct COM (see setting retr play !
> software setting > calibration COM port). v

25. | The measured temperature 51(°C) is out During automatic calibration the
of permitted range [20...50]. measured temperature exceeded the

allowed range.

1. Reduce calibration range (increase
minimum and decrease maximum)
through Automatic calibration
properties.

2. Retry calibrating.

If calibration is still out of range,

calibrate the Thermode manually to

bring it back into range.
26. | Have not been able to read temperatures The program was unable to communicate
from the Thermometer for 60 seconds. with the thermometer.
1. Verlfy_tha_t the thermometer Follow the displayed instructions, and
communication cables are connected retr
properly. v
2. Verify that the thermometer is turned
on.
3. Restart the automatic calibration
procedure.
27. | 1. Check that the thermode is properly Warning notification before automatic
placed in the jig and connected to the Q- calibration.
Sense. . . .
2. During automatic calibration software FOHO.W the displayed instructions, and
. . L continue.
safety protection is lowered; therefore, it is
not allowed to place Thermode on human
subjects
Click YES to continue calibrating.
Click NO to discontinue calibration
28. | Can not open thermometer serial The selected calibration COM port is in
communication port, because it is used by use by the Q-SENSE system.
Medoc Main Station 1. Select the appropriate calibration
COM port through Settings>Software
Settings>General.
2. Retry calibration.
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N2 | Error Message Solution

29. | Q-sense Thermode was not detected by Q- | The Q-SENSE system could not detect
SENSE. one of the enabled Thermodes, and
The Thermode has been disabled. therefore disabled it in order to prevent
1. Make sure that the Thermode is properly | any damage.
connected to the Q-Sense system. . . .

2. Enable the Thermode through the FOHO.W the dlsplayed instructions to
) continue working.

Hardware Settings, General menu.

3. Click Yes to try again.

Or

4. Click No to continue working.

30. | Some of the Safety parameters (Temp Vs. | The Q-SENSE system has detected that
Time) are violating the Q-SENSE safety the modified safety limitations do not
limitations. comply with safety regulations.

1. Click OK to continue working with Select one of the presented options and

current non-approved safety parameters. continue

2. Click Restore to restore safety )

parameters to the Q-SENSE definition. In is not allowed to perform any tests on
human subjects when violating safety
limitations without written approval!

31. | Communication between Q-SENSE and PC Communication between the Q-SENSE
lost while in Test Run mode. Error Code: system and the PC has been lost.
8ooc 1. Restart the Q-SENSE system and

program.
2. Run Self Test.
3. Continue working with the system.
If the problem persists, contact Medoc
service.
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N2 | Error Message

Solution

32.

at Medoc ATS.
at AU TopCoor

services.
1. Press OK.

Error start with:

object.
at

System.NullRefeenceException: Object
reference not set to an instance of an

it.

service.

SQL server could not find COM port or
Virtual COM port and cannot start SQL

2. Copy the file Add SERIALCOM to
registry.reg from Q-SENSE
installation CD to your computer.
The file located in Medoc

Manufacture Remote Assistance
Medoc.SyslInfoHelper.GetSeriaPortNanes() Tools folder.

3. Run the Add SERIALCOM to
registry.reg file by double click on

4. Connect the computer to Q-SENSE
communication port using USB cable.
Make sure that the driver is installed
properly according to Q-SENSE
installation instructions.

5. Turn ON the Q-SENSE system.
6. Start MEDOC Main Station.

If the problem persists, contact Medoc

24.2Faulty System Responses

Table 43: Faulty System Responses

Malfunction

Solution

Thermode does not heat

The Thermode does not heat up, and remains at room
temperature or cold. The Q-SENSE Temperature status,
displayed on status bar, indicates a temperature other than

the current Rest Mode temperature.

The malfunction may be caused by the Thermode, or by the

voltage supplied from the power supply.

1. Verify that the Q-SENSE system is in Online mode.

2. Power OFF the Q-SENSE unit, and replace the

Thermode.

3. Power ON the Q-SENSE unit and check if the

Thermode heats up.

4. Verify that the Q-SENSE system is not in Safe Mode

(Safety indicator, in status bar, is GREEN)
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Malfunction

Solution

Power Failure

Perform power supply and cable check.

1. Check that the power cable you are using is not
damaged. Make sure that the cable and its connectors
are undamaged.

a. Check that the power cable that you are using is
connected properly to Q-Sense Power COM.

Perform power-switch check.

2. Turn ON the main power switch of the Q-SENSE
system.
A green LED indicates it is ON.

* If the problem persists, contact Medoc service for support.

Constant Communication
problems

1. Perform COM port check.

a. Check that MEDOC Main Station is set for
automatic COM port detection (Settings—>Software
Settings).

2. Perform Power checks (see above).
Perform communication cable check.

b. Check that the communication cable is connected
properly.

c. One end must be connected to the back of the Q-
SENSE COM port; the other end to your laptop.

4. Turn ON the Q-SENSE system.

Disconnect and then reconnect the communication cable
from the COM port of the Q-Sense System, while the Q-
Sense system (software and hardware) is running.

6. Restart the Q-Sense system.

Automatic Calibration
Failure

1. Verify you selected proper COM port for Thermometer in
Software Settings menu.

2. Make sure that the operating system decimal symbol is
set to dot.
To change decimal symbol go to Control Panel->Regional
and Languages Options>Regional Options->Decimal
Symbol.

Display Settings

5. Make sure that the font setting on your laptop is set
for 96dpi.

6. Make sure that your screen resolution is set
according to instructions in section 364.1, Page 36.

No TEC Response

1. Power and communication Check.
a. Check that the system is ON.
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Malfunction

Solution

b. Check that communication can be established.
2. Thermode connection check.

a. Make sure that the enabled Thermode is connected
properly to the Q-Sense system.

3. Restart MEDOC Main Station and Q-Sense system.
4. TEC temperatures refresh check.

a. Check that the TEC temperature in the software
status bar is not freezing i.e., see that the
temperature value changes; there should be a
fluctuation of about 0.1°C.

5. TEC response check for Q-sense Thermode only:
Start the Q-Sense system and software.
Go to Settings>Hardware Settings>Thermode.

c. Select the Q-sense Thermode then press the
calibration tab.

d. Change the Thermode temperature using the
temperature spin box.

e. Check if the temperature in the status line has
changed according to the set temperature.

6. Consult Medoc service for further instructions.
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25 Appendix M - Licensed Options
25.1FTP Support

Enables to upload test results to FTP location for collaboration, multi-center studies or backup.
There is an option to automatically save and upload test results immediately after test completion
(requires internet connection).

25.1.1 Export Configuration

Configure the FTP server which will be used when FTP Server is selected during manual export, or
when automatic export option is enabled.

When exporting results to an FTP server the results will be automatically named according to the
following rule: <Site Name>_ <Patient Name>_ <Test Date & Time>

To access the Export Configuration panel: from the top menu bar, select Settings and then
Software Settings.

@ MMS - v.6.3.4.5

Figure 107: Open Software Settings

In the Software Settings window that opens, select the Export tab.
Fs

Figure 108: Software settings export tab selection

The following window will be displayed:
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P -
M) Software Settings 3]

LCummunil:atinn Users Export | Report Options = Results Fields | Patient Fields

P

I'T' Export automatically '

[\ |

Figure 109: Software Settings Export Tab
25.1.1.1  Configure the FTP Upload Server

To configure the server enter the following details:

1. Server URL - the FTP address. Use a specific address including the folder to which you want
the results to be uploaded to. For example: ftp://ftp.my-ftp-server.com/FolderName

2. User name and password required to access the FTP server

3. Site name - an identifier which will be used in the name of the uploaded result file to

distinguish the uploaded file from other files uploaded from different locations.
4. Click Apply to confirm

. Check connection
5. Check the Connection by clicking the “check connection” button -
the red indicator to the right will change to green if the connection is successful.

25.1.1.2 Automatic Export

If automatic export is enabled test results will be automatically uploaded to the FTP server at the
end of a test. A message will be displayed at the end of the test, indicating whether or not the
upload attempt was successful or not. The computer must be connected to a network in order for

the results to be successfully uploaded at the end a test.

To enable automatic export:

1. Make sure the FTP server details are entered correctly and check the connection.

2. Mark the “Export automatically” checkbox.
3. Make sure auto-save option is enabled (see 10.3.1).
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25.2CoVAS

Enables continues pain rating using the USB CoVAS device.

25.2.1 CoVAS Calibration

Calibrating the CoVAS ensures the CoVAS range 0 to 100 corresponds with the left most and right
most point of the slider, respectively.

The CoVAS should be calibrated when:
e It is used for the first time

e Software or firmware are re-installed

To Calibrate the CoVAS:
1. Connect the CoVAS to the Computer (USB connection).
2. In the Hardware Settings windows, select the USB CoVAS tab.

(™) Hardware Settings

®
USB COVAS

OK

Figure 110: CoVAS Calibration Tab

3. Click the Next button and follow the instructions shown on screen (a short version is given
here)

4. Move the CoVAS slider all the way to the left and click the Next button.
5. Move the CoVAS slider all the way to the right and click the Next button.
6. Click Next to save the calibration results.
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7. Click the Finish button to complete the calibrating process; then click OK.

25.3 Patient Record Control

Allows full customization of patient fields including the options to add, remove, rename and
control input.

25.3.1 Control Patient Field Entry Format with Input Masks

When you have several users entering patient data, you can control how the data must be entered
in specific fields in order to maintain consistency. For example, you can set an input mask for the
ID field so the ID numbers will have a very specific format.

Input Masks

An input mask consists of a string of characters which represent the format in which the data
should be entered. The input mask strings consists of Regular Characters, Special Characters,
and Literal Characters.

The Regular Characters represent the alphabetic or numeric characters that must or may be
used to enter data in the field. Refer to Table 44 for a list of Regular Characters and their
definitions.

The Special Characters represent the case and various delimiters and symbols. Refer to Table
45 for a list of Special Characters and their definitions.

The Literal Characters are characters that are not Regular Characters or Special Characters.
They are inserted as is into the edit box of the field and the curser will skip over them during
editing. The use a Regular Character or a Special Character as a Literal Character, add a
backslash (\) before.

Table 44: Regular Characters

Character | Definition

L User must enter a letter (A-Z, a-z)

I User can only enter a letter (A-Z, a-z) but it is not required

>

User must enter a letter (A-Z, a-z) or a number (0-9)

User can only enter a letter (A-Z, a-z) or a number (0-9) but it is not required

0Ol o

User must enter any character

User can enter any character but it is not required

User must enter a number (0-9)

User can enter only a number (0-9) but it is not required

#| O] o] 0

User can enter only a number (0-9) and a plus (+) or minus (-) but it is not
required

Table 45: Special Characters

Character | Definition

> All the characters that follow are converted to upper case
< All the characters that follow are converted to lower case
<> No case checking is performed
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/

Used to separate months, days and years in dates. The character used depends on
the regional settings of the computer

Used to separate hours, minutes and seconds in time values. The character used
depends on the regional settings of the computer

Currency symbol. The symbol used depends on the regional settings of the
computer

Examples

1. A mask for entering a telephone number: (999)000-00-00. Each ‘0’ Regular Character
requires a number in the corresponding position. No humber in these positions can be
omitted. The Regular Character ‘9’ represents an optional area code. Only a number can be
entered in these positions but it is not required. The *-* and ‘(* and ‘)’ characters in the
mask are literal. A telephone number entered could be: (555)222-33-22 or 222-33-22.

2. A mask for entering a sequence with numbers and letters: \A>LL-00. The "\A’ represents a
Literal Character which will be entered as ‘A’. The *>’ specifies that following characters will
be converted to upper case. The 'LL’ indicates that two letters must be entered in this
position. The *-' is a Literal Character. The ‘00’ is a placeholder for 2 nhumbers. An entry to
this field can be: ASD-88.

25.3.2

Add/Remove Patient Fields

To define and add Patient Card Fields to the Patient Details dialog:

1. From the Patient Card Fields list, select the required fields from the Mandatory or Optional
fields, or add a new field from the user-defined list. Add an input mask if needed.

2. To remove a Patient Field, remove the selection mark from the field

Click the Apply button to confirm changes.
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=" -
J Software Settings

Y
@ ), Input Mask

Driver License
Social Security Number

4 Mandatory b

Fields available
for entering
patient data

Figure 111: Patient Fields with Input Masks

View patient details

G -G

120032 7/14/1965

(972)555-43-33 ASD-12

Figure 112: Patient Card with Selected Patient Fields

To add Patient Fields to the Patient Table:
4. Select fields to add from the Patient Card Fields list and click the Move Right button

"

5. Click the Apply button to confirm changes

To remove Patient Fields from Patient Table:

1. Select fields to remove from the Patient Table Fields and click the Move Left button

2. Click the Apply button to confirm changes

To restore the default Patient Fields:

1. Click the Restore button to restore default Patient Fields.

2. Click the Apply button to confirm changes
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25.4Pain Rating

Enables advanced options for monitoring Patient Response: customized range for numerical pain
rating scale, multiple ratings per trial.

25.4.1 Pain Rating Parameters Configuration
Pain rating is available only for Ramp & Hold program.

Advanced parameters available with pain rating license can be configured while creating or editing
any Ramp & Hold program.

The following options can be configured:

Enable Pain Rating
First pain rating, sec
Pain rating interval, sec

Waiting time for response (sec) 10

Figure 113: Pain Rating Parameters

Enable Pain Rating checkbox - When checked enables pain rating patient response
First pain rating -determines the time of the first pain rating.

Default value is "0", meaning that the first pain rating will occur at the end of the trial.
Pain rating interval - determines the interval between pain ratings.

Default value is "0", meaning there will be only one pain rating in trial, at time determined by first
pain rating parameter value.

Note: The amount of paint ratings in trial is determined by combination of first pain rating, pain
rating interval and duration time parameters value. For example, if the duration time of the trial is
20 segc, first pain rating value is 5 sec and pain rating interval value is 5 sec, there will be 4 pain
ratings in the trial 5, 10, 15 and 20 sec after reaching the destination temperature.

Waiting time for response - determines the time for which the pain rating dialog will remain on
the screen waiting for user to respond.

In addition, Pain rating limits can be configured from Test Configuration tab in Test Settings
window:
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= .
(M) Test Settings

Test Configuration

Figure 114: Pain Rating Limits
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26 Appendix N - fMRI functionality
26.1 fMRI Thermode

A

A
A
A
@

@

26.1.1

Q-sense fMRI Thermode and accessories are defined and marked as MR
Conditional equipment according to the ASTM F2503-08.

Q-sense MR filters are defined and marked as MR Unsafe equipment
according to the ASTM F2503-08.

WARNING:

Make sure that the Thermode is unblemished in order to prevent potential
harm to the test subject.

WARNING:

To avoid the risk of electric shock, this equipment must only be connected
to a supply mains with protective earth.

The fMRI Q-sense system was tested in the following MR environments:
Field Strength: 3T and 7T; Max. Spatial gradient: 72 mT/m
Max. dB/dt: 346 T/m/s; RF Fields: max. power 35KW pep;

TX bandwidth: 800kHz; RX bandwidth: 500Hz-1MHz; maximal RF field
strength: 24,7 uT CP

SAR: whole body 4 W/kg, head 3.2 W/Kg

The fMRI Q-sense system was tested in the following MR Sequences:
1. Echo Planer Imaging (EPI) bold (fMRI)

2. rf_noise and rf_noise spectrum electromagnetic noise interference
(Siemens protocol)

Q-sense system configuration in fMRI mode:

The fMRI Q-sense system includes the following components:

. ® Control room thermode cable

. A Q-Sense fMRI Thermode
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The Q-sense fMRI thermode incorporates an EMI filter designed to reduce and prevent

electromagnetic interference noise from penetrating into the scanner room. The fMRI filter
includes:

* Minimal insertion loss : 10MHz/13dB, 100MHz/50dB, and 1GHz/70dB.
= Capacitance: 4000pF

* Non-ferromagnetic filter components

penetration panel, with the thermode air tube to be passed through a
waveguide of appropriate dimensions (according to the MRI scanner
manufacturer design).

0 The filters are to be connected via appropriate 9-pin D-type cutouts in the

Loosely connected cable connectors or use of conductive tape or braid
may lead to interference noise and imaging artifacts.

The fMRI Thermode is "MR Conditional”. An extended 13 [m] cable connects between the Q-sense
system, which is located outside of the MRI control room, and the Thermode that is located in the

MRI room. The part of the thermode inside the room is 10 [m] long, and the part outside the
room is 3 [m] long.

"MR Conditional” means an item that has been demonstrated to pose no
known hazards in a specified MR environment with specified conditions of
use.

26.1.2 Installation —MR Filter

1. Complete the setup and installation procedure as described for a regular Q-sense system,
according to the System Block diagram below.

2. Connect the system devices according to the following stages:
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Penetration Panel

oo = mm mm Em Em oEm = =y,

i~ N\

)

PR el BB

/ N

fMRI Scanner

fMRI Thermode

|

Mains AC Power Thermode

-12vDC, 2m—| Q-Sense Main Unit

100 - 240V Adaptor
(] 4 :

| cabie 10m

f \
I |
[ |
I I
I D type Panel I I D type Panel I
I USEB Communication Thermode filter connector I filter connector I
cable 3m
I |
l ] I I
— apto
\ ptop / \\ /
~ d _—— e o = = = =

Figure 115- fMRI room setup

2.1. Connect the Q-sense system so it would be placed in the MRI control room, while the
Thermode itself is placed in the MRI room, as shown in the diagram:

2.2. Make sure your PC, Q-sense fMRI unit are all OFF.

2.3.Install the fMRI thermode Control Room part (see Figure 116) according to the following
instructions:

2.3.1. Connect the D type panel filter connector on your MRI room penetration panel.
2.3.2. Connect Q-sense fMRI Connectors to the Q-sense fMRI unit

Q-sense Connectors

(To Q-sense unit)

D type >
panel filter
connector

Figure 116: Q-sense fMRI Thermode Control Room part WA 00281
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Q-sense fMRI
Thermode -(Inside MRI
scanner room)

Q-sense fMRI
Thermode signal
connector (to
penetration panel
inside MRI scanner
room)

Q-sense fMRI
Thermode air
connector to Q-Sense
fMRI box via
waveguide

Figure 117: Q-sense fMRI Thermode Shielded room part AS 00412

2.4.See Figure 117, for description of the fMRI Thermode- Shielded room part components:
2.4.1. Q-sense fMRI Thermode
2.4.2. Q-sense fMRI Thermode connector
2.4.3. Connection to MRI

2.5. Connect the main power cord to the Q-sense system.
3. The fMRI Thermode- Shielded room part - should be placed inside the fMRI room. All the other
devices' connectors should be placed outside of the fMRI room.
4. Connect the required devices and accessories, as described in Figure 115
Conduct three phantom tests:
5.1. Conduct the test, when the Q-sense is OFF,
5.2. Conduct the test, when the Q-sense is ON and software is OFF,
5.3. Conduct the test, when the Q-sense and software are ON and software test is running.
6. The installation is finished if all three tests are passed successfully.

The SIP/SOPs (signal input and outputs) must be connected to medical
grade safety approved equipment for Canada and the United States, by a
recognized certification agency, which is connected to the common
protective earth of the system.
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26.2 TTL functionality

Q-sense systems with FMRI thermode functionality support TTL functionality which can be used
for synchronization with external systems.

26.2.1 Q-sense fMRI side panel

Figure 118: Q-sense fMRI side panel

26.2.2 TTL set up
Q-sense can send 1-bit TTL from the side panel TTL OUT BNC connector (see Figure 118)

M) Hardware Settings Q-Sense

Manual

High i
Medium
= -

Figure 119: HW settings for Q-sense fMRI

The polarity of the TTL can be configured in Q-sense hardware settings. See figure 119
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1. TTL Polarity:

1.1.TTL OUT: Configure the Polarity of TTL OUT pulse: 5V or (-)5V. For 5V: The TTL is OV
when Idle and 5V when triggered. For (-)5V: The TTL is 5V when Idle and OV when
triggered.

1.2.TTL IN: The polarity of the TTL IN does not need to be configured. Q-sense will
automatically detect if it is 5V or (-)5V.

2. TTL Pulse out Duration:
2.1.Configure the duration of the TTL OUT. The allowed range is: 50 - 1000 msec.

26.2.3  Standard Event Configuration

TTL trigger shall be sent only if the standard event is configured in the
program

To configure standard events in the required program, follow the steps detailed below:

1. From the Programs screen, select the program you want to configure standard events for and

double click to open the program editor or click on the edit program button
2. From the list of parameters, select the Standard Events option

1S1I Min (sec) :ﬁ )
1SI Max (sec) Do
>
>
.

-
4
4
Standard Events 4

)

Temperature Events

Figure 120: Standard Events in Program Editor
3. Click the blue arrow on the right to open the standard event editor.

— 4

ISI Max (sec) Do
4
Standard Events ._4

+*.Y
|

Temperature Events Standard Events

— 14

TTL  Sound
) - -

Editor

Figure 121: Standard Event

4. Mark TTL option to activate TTL OUT signal output for various standard events (Onset,
Temperature UP/DOWN, End of duration, End of test).

26.2.4 TTL specifications
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Parameter Description
Synchronization options Externally trigger the onset of stimulus
TTL Input Voltage: £ 5V

Current: 10 - 15 mA

Minimum Duration: 10 msec.

Synchronization options Can indicate various events during stimuli (depending on
TTL Output protocol used)
Voltage: £ 5V

Current: 2 mA
Duration: 50 - 1000 msec

26.3 Blower control

Regular thermode 30x30 is cooled by an internal fan in the thermode enclose. fMRI 30x30
thermode is cooled via the air tube by a blower inside the main unit.

It is possible to turn off the blower for work in an office environment.

In order to do that there is a need to defined two types of thermodes in the HW settings.
Thermode type "30x30” and thermode type “fMRI 30x30”. By setting thermode type 30x30 as
current you will disable the blower and activate the regular thermode fan. Setting thermode type
as fMRI 30x30 will activate the blower and disable the regular thermode fan.

For additional info please refer to section 10.2.3

providing inaccurate temperatures, and may result in the test being
stopped due to safety mechanisms being activated, especially in
prolonged cold detection threshold protocols.

0 Use of a thermode without appropriate cooling may result in the thermode

Ensure that the correct thermode type is selected in HW settings.
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